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Discovering the value of IBM WebSphere Application Server V8.0 for Administrator

Lab 1 WebSphere Application Server V8 Installation and
Configuration

The objective of this lab is to provide you with an understanding of the basic WebSphere Application
Server and WebSphere Application Server — Network Deployment infrastructure. Within the constraints
of the machine image available for the exercise you’ll configure a typical WAS environment comprised of
an HTTP server, WebSphere Application Server, DB2 database server and LDAP server for application
use. You'll then add a WAS-ND Deployment Manager and federate the application server environment
into WAS-ND to adding scalability, failover, and centralized management to your environment.

This lab is provided AS-IS, with no formal IBM support.

1.1 Lab requirements

WebSphere Application Server — Network Deployment Version 8.0

1.2 What you should be able to do

At the end of this lab you should be able to

* Install WebSphere Application Server using IBM Installation Manager and configure WebSphere
Application Server for a departmental deployment on a single server

* Configure a WebSphere Application Server — Network Deployment cluster for a departmental
deployment on a single server

* Configure WAS and WAS —ND to use DB2 for application data

* Configure a Federated Repository for WAS and WAS-ND to use an LDAP server for user
authentication.
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1.3 Introduction

This lab is intended as a primer on the basic configuration of WebSphere Application Server for those not
already familiar with it, or a refresher for those already skilled in WebSphere Application Server.

The aim of the lab is to walk though the steps that a systems administration would perform for a typical
WebSphere Application Server (and WAS-ND) deployment, using the information typically provided or
dictated by organizational standards; e.g. installation location, database configuration, LDAP
configuration.

1.4 Exercise instructions

Some instructions in this lab may be Linux ® operating-system specific. If you plan on running the lab on
an operating-system other than Linux®, you will need to execute the appropriate commands, and use
appropriate files ( .sh vs. .bat) for your operating system. The directory locations are specified in the lab
instructions using symbolic references, as follows:

Reference variable Windows® location Linux®or UNIX® locations

lusr/WebSphere/AppServer
<WAS_HOME> C:\IBM\WebSphere\AppServer
lopt/WebSphere/AppServer

lusr/WebSphere/AppServer/profiles/AppSr
v01

<
PROFILE_HOME C:\IBM\WebSphere\AppServer\profiles\AppSrv01 lopt/WebSphere/AppServer/profiles/AppSr

> vO1
<RAD_HOME> C:\Program Files\IBM\SDP lopt/IBM/SDP
<LAB_FILES> C:\Labfiles80 /Labfiles80
<TEMP> C:\temp /tmp

Note for Windows users: When directory locations are passed as parameters to a Java program such as
EJBdeploy or wsadmin, it is necessary to replace the backslashes with forward slashes to follow the Java
convention. For example, C:\Labfiles80\ would be replaced by C:/Labfiles80/
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1.5 Deploying a WebSphere Application Server Departmental
Solution.

This lab will assume that an departmental application infrastructure; consisting of an HTTP Server and
WebSphere Application Server instance, needs to be deployed and configured to use LDAP, and a DB2
database, needs to be deployed in an environment as depicted below.

Since the enterprise is providing a proxy server in the DMZ in order to provide for security we will be configuring
the HTTP server to run on the same server as the application server and will thus be able to safely and
securely leverage the WebSphere Application Server capability to manage IBM HTTP Server.

As is often the case in many enterprises, much of the infrastructure is outside the domain of the application
server administration team. While most often the LDAP server and Database server are located on external
servers, for the purposes of this lab both will be located on the same server as the application server, though
the actual administration of LDAP and DB2 performed by others, while the WAS configuration to use these
services will be part of this exercise.

SHeu-§-9

- IP Sprayer LDAP
Firewall Firewall Web Server ==
Proxy Server with WAS Plugin Server
T
Internet
And
Intranet
Firewall

@ wsadmin e Adminconsole
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1. Take a VM snapshot (to insure you have a recovery point) , provide a meaningful name such as “starting
image” (This is an optional step)

B 2011 T3 v3 - VMware Workstation

File Edit View Team Windows Help
il ? ) Power »
‘7‘ Removable Devices »
Pause Shift+Ctrl+P
Q Applications
I Change deskto|  Snapshot »  Take Snapshot...

2. Start the Virtual Machine image
___a. Log in using “root” with the password “password”

Typically you wouldn’t log in using “root.” Since most of the lab is administrative activities, it makes sense
to log in as “root” in this environment. Please don’t use root for regular access on your servers.

_____ 3. WAS V8 has a new install capability with IBM Install manager.
___a. Open a Terminal session and navigate to the directory with the install image of Install Manager
# cd /Labfiles80/IBM_IM
___b. Run the Install Manager install # ./install

r

o root@think:/Labfiles80/IBM_IM (=)(a])[x]

File Edit View Terminal Tabs Help

[root@think ~]# cd /Labfiles80/IBM IM/ =
[root@think IBM IM]# ./installD

You'll see the following screens. Take the defaults as illustrated in the images below
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6-) IBM Installation Manager =]l
Install Packages
Select packages to install:
Installation Packages Status Vendor License Key Type

~ [ [ IBM® Installation Manager
1. Version 1.4.4 Will be installed 1BM No key required

["] Show all versions Check for Other Versions, Fixes, and Extensions

Details

IBM @ Installation Manager 1.4.4
IBM® Installation Manager More info...

* Repository: /Labfiles80/IBM_IM

° P ] [Ccen ]
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IBM Installation Manager

Install Packages Ef‘>;

Read the following license agreements carefully.

Install I Licenses ) Location Summary

International Program License Agreement

Part 1 - General Terms

BY DOWNLOADING, INSTALLING, COPYING, ACCESSING, CLICKING ON AN "ACCEPT" BUTTON, OR OTHERWISE USING THE PROGRAM, LICENSEE
/AGREES TO THE TERMS OF THIS AGREEMENT. IF YOU ARE ACCEPTING THESE TERMS ON BEHALF OF LICENSEE, YOU REPRESENT AND WARRANT
THAT YOU HAVE FULL AUTHORITY TO BIND LICENSEE TO THESE TERMS. IF YOU DO NOT AGREE TO THESE TERMS,

- DO NOT DOWNLOAD, INSTALL, COPY, ACCESS, CLICK ON AN "ACCEPT" BUTTON, OR USE THE PROGRAM; AND

- PROMPTLY RETURN THE UNUSED MEDIA, DOCUMENTATION, AND PROOF OF ENTITLEMENT TO THE PARTY FROM WHOM IT WAS OBTAINED FOR
/A REFUND OF THE AMOUNT PAID. IF THE PROGRAM WAS DOWNLOADED, DESTROY ALL COPIES OF THE PROGRAM.

1. Definitions

“"Authorized Use" - the specified level at which Licensee is authorized to execute or run the Program. That level may be measured by number
of users, millions of service units ("MSUs"), Processor Value Units ("PVUs"), or other level of use specified by IBM.

“IBM" - International Business Machines Corporation or one of its subsidiaries.
“License Information" ("LI") - a document that provides information and any additional terms specific to a Program. The Program's Ll is available
at www.ibm.com/software/sla. The LI can also be found in the Program's directory, by the use of a system command, or as a booklet included

with the Program.

“Program"” - the following, including the original and all whole or partial copies: 1) machine-readable instructions and data, 2) components, files,
and modules, 3) audio-visual content (such as images, text, recordings, or pictures), and 4) related licensed materials (such as keys and

) I do not accept the terms in the license agreement

(I

1accept the terms in the license agreement Print Al |

Lab

1
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IBM Installation Manager

Install Packages ::}—

Select a location for Installation Manager.

Install Licenses Location Summary

@ Once installed, IBM Installation Manager will be used to install, update, modify, manage and uninstall your packages.

Installation Manager Directory: |/opt/IBM/InstallationManager/eclipse ] ‘ Brgwsem]

Disk Space Information

Volume Available Space

/ 7.06 GB

’ Cancel
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IBM Installation Manager

Install Packages
Review the summary information.

Install Licenses Location

Target
Package Group Name: IBM Installation Manager
Installation Directory: /opt/IBM/InstallationManager/eclipse

Packages

Packages

[l IBM® Installation Manager 1.4.4

Environment

Arabic, Brazilian Portuguese, Czech, Danish, English, French, German,
Greek, Hungarian, Italian, Japanese, Korean, Lithuanian, Polish, Russian,
Simplified Chinese, Slovenian, Spanish, Traditional Chinese, Turkish

» Repository Information

@

Disk Space Information
Total Available Space
/ 7.06 GB

Total Download Size: 115.90 MB
Total Installation Size: 210.25 MB

‘ < Back ‘ Install ] ’ Cancel

Lab 1
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IBM Installation Manager

Install Packages ::}—

o The packages are installed. View Log File

The following package was installed:

v %, IBM Installation Manager
[]j IBM® Installation Manager 1.4.4

Click on "Restart Installation Manager" to launch the new Installation Manager and to start
installation of other package(s).

@ estart Installation Manager
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IBM Installation Manager
File Help

IBM Installation Manager

E>Q Install

Install software packages.

Update

Discover and install updates
and fixes to installed
software packages.

Roll Back
Modify
Change installed software
packages by adding or CQ Uninstall
removing features and
functions.

After it is installed you can also launch Install Manager as shown below:
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P LlEE LY Places  System

@ Accessories ’

@ Graphics

@ IBM Software Delivery Platform

& Internet ’

“ Programming ’
Sound & Video >
Q System Tools »

B T3 >

'ﬁ Add/Remove Software

~
ﬁ IBM Installation Manager 9 IBM Installation Manager

<8 Uninstait-is aitation Manager

Now that Install Manager is in place you can start installing a wide range of IBM products. Install manager

does need to know where to find the install images. The images are stored

in a repository. The next steps

will show how to configure Install Manger to access a repository that has been built for you for this lab.

___c. Click File -> Preferences for the IBM Installation Manager Preferences as shown below

@) Applications Places System

]' IBM Installation Manager

(-0
[0 e

Open ’
1ager

= View Log
=| Installation History

‘o View Installed Packages

Preferences...

Exit
r—l Install

(=) Install software packages.

: Update
= P

Tew Discover and install updates
Ny and fixes to installed

___d.Click“ Add Repository “

48 ’/Jf Manage Li

Page 14
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@) Applications Places System

Preferences

I |

Appearance

Files for Rollback

P Help

P Internet
Passport Advantage
Updates

Repositories

Repositories:

Location

Connection ( [ Add Repository... ]

AN

___e. Browse to the directory shown below and click “OK”. The directory is accessed by clicking on “File
System” on the left and then /media/lMRepository/repository.config

&

Select a Repository x|

@‘ media “ lMReposItory’

Places Name ¥ Modified :
@ root J atoc 08/29/2011
#® Desktop [ features 09/09/2011
O File System J files 09/11/2011
< Floppy Drive J lost+found 08/29/2011
- £ native 09/11/2011
- £ Offerings 09/11/2011
3 plugins 09/11/2011

‘repository.config;diskTag.inf;*.jar;*.zip =

¥ Cancel ’ ‘ QBQK

___f. Repeat the previous step to add a repository for iFix /wasmaint/8.0.0.0-WS-WASND-IFPM44786

Lab 1
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Select a Repository

B) (o wasmatee]

Places Name ¥ Modified :
@ root ¥ 8.0.0.0-WS-WASND-IFPM44786.zip 10/06/2011

2 Desktop

O File System

< Floppy Drive

1]

(d

repository.config;diskTag.inf;* jar;*.zip

4

‘ ¥ Cancel I‘ QBQK

___g. Test the connection to the repository with the “Test Connection” button

]" a Test Connection x|

@ All the selected repositories are connected.

OK

Your Installation Manager screen should now look like the image below. At this point we are ready to
start installing software that exists in the repository.
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Repositories
Repositories:

Appearance —
Location Connection ¢
Files for Rollback . 1 Add Repository...
b Help ] /media/MRepository/repository.config %8
4] ;wasmaint/8.0.0.0-WS-WASND-IFPM44786 zip %
P Intemet
Passport Advantage
Updates
l Test Connections
Service repositories are remote locations where updates or extensions to packages (including the Installation
Manager itself) are stored.
/] Search service repositories during installation and updates.
‘Restore Qefauns} ‘ Apply
@ [ OK l Cancel

___h. Click “OK” to return to the Install Manager home.

Install WebSphere Application Server
___a. Click Install from the Installation Manager

IBM Installation Manager

- Install
Install software packages.

Select the software to install as show below then click Next.

Lab 1
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(-) IBM Installation Manager

Install Packages
Select packages to install:

W IBM HTTP Server for WebSphere Application Ser

Installation Packages Status Vendor License Key Type

IBM HTTP Server for WebSphere Application Server 8.0.0.0

WebSphere Application Server is based on Apache HTTP Server. More info...

® Renncitnry: /media/IMRennsitary

E—
° G D)

___b. Select the fix and click Next again then OK.

@;, Version 8.0.0.0 Will be installed IBM
v [l 1BM WebSphere Application Server Network Def
@,n Version 8.0.0.0 Will be installed  I1BM
- [l Web Server Plug-ins for IBM WebSphere Applica
[f?'u Version 8.0.0.0 Will be installed  I1BM
v [[) WebSphere Customization Toolbox
@_n Version 8.0.0.0 Will be installed IBM
[T] Show all versions Check for Other Versions, Fixes, and Extensions
Details

IBM HTTP Server for WebSphere Application Server provides advanced web server capabilities with
consistent management and security in a WebSphere Application Server environment. IBM HTTP Server for

Page 18
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(-0 IBM Installation Manager
Install Packages
Select the fixes to install.

Fixes Recommende: Vendor

57 W IBM WebSphere Application Server Network Deployment 8.0.0.0

[ 8.0.0.0-WS-WASND-IFPM44786 8.0.0.20110804_1105

Check for Other Fixes

Details

IBM WebSphere Application Server Network Deployment 8.0.0.0

IBM WebSphere Application Server Network Deployment is a production-ready Java Platform, Enterprise
Edition (Java EE) compliant application server for the deployment of enterprise web services solutions for
dynamic e-business. It is the next level in application serving beyond the WebSphere Application Server
base edition because it provides advanced web services and clustering capabilities. More info...

v

- o e D
[

___c. Select Accept the License and Click Next
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Install Packages
Read the following license agreements carefully.

Install ‘ Licenses ) Location Features Summary

International Program License Agreement

[y H@|

Part 1 - General Terms
BY DOWNLOADING, INSTALLING, COPYING, ACCESSING, CLICKING ON AN "ACCEPT" BUTTON, OR OTHERWISE USING THE PROGRAM, LICENSEE
/AGREES TO THE TERMS OF THIS AGREEMENT. IF YOU ARE ACCEPTING THESE TERMS ON BEHALF OF LICENSEE, YOU REPRESENT AND WARRANT
THAT YOU HAVE FULL AUTHORITY TO BIND LICENSEE TO THESE TERMS. IF YOU DO NOT AGREE TO THESE TERMS,

- DO NOT DOWNLOAD, INSTALL, COPY, ACCESS, CLICK ON AN "ACCEPT" BUTTON, OR USE THE PROGRAM; AND

- PROMPTLY RETURN THE UNUSED MEDIA, DOCUMENTATION, AND PROOF OF ENTITLEMENT TO THE PARTY FROM WHOM IT WAS OBTAINED FOR
/A REFUND OF THE AMOUNT PAID. IF THE PROGRAM WAS DOWNLOADED, DESTROY ALL COPIES OF THE PROGRAM.

1. Definitions

"Authorized Use" - the specified level at which Licensee is authorized to execute or run the Program. That level may be measured by number
of users, millions of service units ("MSUs"), Processor Value Units ("PVUs"), or other level of use specified by IBM.

"IBM" - International Business Machines Corporation or one of its subsidiaries.

“"License Information" ("LI") - a document that provides information and any additional terms specific to a Program. The Program's Ll is available
at www.ibm.com/software/sla. The LI can also be found in the Program's directory, by the use of a system command, or as a booklet included
with the Program.

v

|print AL

@ ‘ < Back ” Next > ] ‘ Cancel

___d. Select Shared Resources Directory /opt/IBM/IMShared and click Next.

) IBM Installation SEES
Install Packages ; ./s—
Select a location for the shared resources directory. °

tai License Loc

When you install packages, files are stored in two locations:

1) The shared resources directory - resources that can be shared by multiple packages
j 2) The installation directory - any resources that are unique to the package that you are installing.

Important: You can only select the shared resources directory the first time you install a package with the IBM
Installation Manager. For best results select the drive with the most available space because it must have adequate
space for the shared resources of future packages

Shared Resources Directory: |/optIBMAMShared Browse...

Disk Space Information

Volume Available Space
/ 6.82 GB

Cancel

___e. Accept the default for the package group installation and directory. Click Next.

Page 20 Installation and Configuration



IBM Software IBM Proof of Technology

v
al
x|

- IBM Installation Manager

Install Packages
The packages will be installed into the indicated package groups. Select the package group to change
the installation directory.

Install Licenses Location Features Summary

Package Group Name Installation Directory

y

~ -, IBM HTTP Server V8.0 Jopt/IBM/HTTPServer
[[) IBM HTTP Server for WebSphere Application Ser

< %, IBM WebSphere Application Server Network Deploy /opt/IBM/WebSphere/AppServer
= [[J IBM WebSphere Application Server Network Def
([ ! [T»)

Package Group Name: IBM HTTP Server V8.0

Installation Directory: |/opt/IBM/HTTPServer ] IBgowse...l

Details Disk Space Information

Shared Resources Directory: /opt/IBM/IMShared Volume  Available Space

/ 6.82 GB

® BT )

__f. Accept the default for Language and click Next.

B
al
x|

2 IBM Installation Manager

Install Packages
Select the translations to install.

Install Licenses Location Features Summary

Select the translations for the packages that will be installed to package group Web Server Plug-ins for IBM
WebSphere Application Server V8.0, IBM HTTP Server V8.0, IBM WebSphere Application Server Network
Deployment V8.0, WebSphere Customization Toolbox V8.0.

y

Translations Supported by All

V]

v Translations Supported by Only Some

[] Brazilian Portuguese [] Czech [’] Erench [] German ["] Hungarian

[] Italian O Japanese ['] Korean [’] Polish [] Romanian

["] Russian [} Simplified Chinese O Spanish [7] Traditional Chinese

° e G D

——

___g. Select the packages to install as shown below and click Next. Note that we are deselecting the
three subcomponents of the WebSphere Network Deployment V8 installation.

Lab 1
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IBM Installation Manager

Install Packages |;'}'_J

Select the features to install.

Install Licenses Location Features Summary

Features

) 1BM HTTP Server for WebSphere Application Server 8.0.0.0
+ [ [[J IBM WebSphere Application Server Network Deployment 8.0.0.0
O EJBDeploy tool for pre-EJB 3.0 modules

» M f§ Stand-alone thin clients, resource adapters and embeddable containers

[0 sample applications
[ web Server Plug-ins for IBM WebSphere Application Server 8.0.0.0
3 [[J WebSphere Customization Toolbox 8.0.0.0

[[] Show dependencies Expand AIIHgoIIapse AII] [Bestore Default

v#- Selected by Installation Manager because of dependencies

Details

Stand-alana thin rliante racannrca adanterc and amhaddahla rantainarc

v

@ | < Back i Next > h | Cancel

___h. Select port 80 for the Web Server

(2]

IBM Installation Manager

Install Packages ﬁ}r—_l

Fill in the configurations for the packages.

Install Licenses Location Features Summary

< [[) IBM HTTP Server for Websy Configuration for IBM HTTP Server for WebSphere Application
Server 8.0.0.0
™ Web Server Configuratid . .
Web Server Configuration

ports below 1024.

Specify a port number for IBM HTTP Server to communicate. The default pc
the default port is already in use, then change to another port that is availak
Running IBM HTTP Server without root or Administrative privileges might res:

D) ([ I

[»)

° (= oo D e

| —

___i. Review the install package list, which shows both WAS and the ifix and click Install as shown below.
This might be a good opportunity for a break. © The installation may take about 10 minutes.

Page 22

Installation and Configuration



IBM Software IBM Proof of Technology

a IBM Installation Manager X
Install Packages |:{}'—]
Review the summary information.

Install Licenses Location Features .
Target
Shared Resources Directory: /opt/IBM/IMShared
Packages
Packages Installation Directory
~ -, Web Server Plug-ins for IBM WebSphere Application Server V8.0 /opt/IBM/WebSphere/Plugins 3
[l Web Server Plug-ins for IBM WebSphere Application Server 8.0
<~ %, IBM HTTP Server V8.0 Jopt/IBM/HTTPServer
[} IBM HTTP Server for WebSphere Application Server 8.0.0.0
< %, IBM WebSphere Application Server Network Deployment V8.0 Jopt/IBM/WebSphere/AppServer
= [[J IBM WebSphere Application Server Network Deployment 8.0.0 |
[[#8.0.0.0-WS-WASND-IFPM44786 8.0.0.20110804_1105
<~ %, WebSphere Customization Toolbox V8.0 Jopt/IBM/WebSphere/Toolbox
+ [[J WebSphere Customization Toolbox 8.0.0.0
(> Web Server Plug-ins Configuration Tool
(> Profile Management Tool (z/OS only)
[[> z/OS Migration Management Tool v
V| —
® (Upsar ) cancer |

___j. Once the install has completed you should see the dialog below. Select “None” (Do Not Start the
Profile Management Tool) and Click Finish - Exit the Installation Manager at this point

e and behavior, get help, or log out IBM Installation Manager =S

Install Packages f—]

0 The packages are installed. View Log File

The following packages were installed: Which program do you want to start?
v %, IBM HTTP Server V8.0 () WebSphere Customization Toolbox

[ 1BM HTTP Server for WebSphere Applica | - profile Management Tool to create a profile.
v "?M WebSphere Application Server Network O Profile Management Tool to create an applica

< [[J IBM WebSphere Application Server Netw © None
#8.0.0.0-WS-WASND-IFPM44786 8.0.0.

v %, Web Server Plug-ins for IBM WebSphere Ap

[} Web Server Plug-ins for IBM WebSphere
v %, WebSphere Customization Toolbox V8.0

[ WebSphere Customization Toolbox 8.0
(G ! I [) [ I [»)

Note: If the packages support rollback, thg temporary dire;tory contains rollback files for installed
packages. You can delete the files on the § ¢ preference page.

® WEE,

——

___ k. Exit the Installation Manager

Lab 1
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6-) IBM Installation Manager

[ oo

Open »

= View Log pager

= Installation History

o View Installed Packages

Preferences...

'%] . Install

Note: You installed WAS, IBM HTTP Server, and an ifix, demonstrating a “one pass install”.

5. Create an application server profile
___a. In a terminal window change directories to
lopt/IBM/WebSphere/AppServer/bin/ProfileManagement using the command

cd /opt/IBM/WebSphere/AppServer/bin/ProfileManagement as shown below

|'_"'- root@think:/opt/IBM/WebSphere/AppServer/bin/ProfileManagement

File Edit View Terminal Tabs Help

[root@think ProfileManagement]# cd /opt/IBM/WebSphere/AppServer/bin/ProfileManag:
ement
[root@think ProfileManagement]# I

.

___b. Launch the WebSphere Customization Toolkit (formerly the Profile Management Tool ) using the
command ./pmt.sh as shown below

= root@think:/opt/IBM/WebSphere/AppServer/bin/ProfileManagement M=)
File Edit View Terminal Tabs Help

[root@think ProfileManagement]# ./pmt.sh

0
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6. Create a WebSphere Application Server Profile, installing the Admin Console (ISC) and sample

application, configuring administrative security with the user “wasadmin” and password “wasadmin”.

___a. Select “Create” to start the profile creation process

‘Applications Places System

WebSphere Customization Toolbox 8.0
File Window Help

B [@Profile Management Tool] €3 welcome
(®) Profiles

Profile name Environment Profile path

Note: Even though you launched the Profile Management Tool with the command pmt.sh you’ll
notice that the WebSphere Customization Toollbox launched. A subset of this new toolbox is

installed with WAS which includes the Profile Management Tool and the Configuration Migration
Tool.

{©)Profile Management Tool "Welcome.’

Welcome &3

Welcome to the WebSphere Customization Toolbox

Select a tool in the following list to display the welcome information for that tool. To launch a tool, select

a tool in the list, and click Launch Selected Tool. Alternatively, select Window > Open Perspective and
select a tool in the list.

List of provided tools:

Profile Management Tool

Configuration Migration Tool
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___b. Highlight “Application Server” and click “Next” as shown below.

A Profile Management Tool 8.0

Environment Selection v

Select a specific type of environment to create.
Environments:

¥ WebSphere Application Server
Cell (deployment manager and a federated application server)

Management

Application server

Custom profile

Secure proxy (configuration-only)

__c. Select “Advanced Profile Creation” as shown below.

Profile Creation Options

Choose the profile creation process that meets your needs. Pick the Typical option to allow the Profile Management Tool
assign a set of default configuration values to the profile. Fick the Advanced option to specify your own configuration
values for the profile.

(O Typical profile creation

Create an application server profile that uses default configuration settings. The Profile Management Tool assigns

unique names to the profile, node, and host. The tool also assigns unique port values. The administrative console
and the default application will be installed. You can optionally select whether to enable administrative security. Th
tool might create a system service to run the application server depending on the operating system of your mach
and the privileges assigned to your user account.

Note: Default personal certificates expire in one year. Select Advanced profile creation to create a personal
certificate with a different expiration.

@ Advanced profile creation§

Create application server using default configuration settings or specify your own values for settings such as the
location of the profile and names of the profile, node, and host. You can assign your own port values. You can

optionally choose whether to deploy the administrative console and Sample applications, and create a Web serve
dafinitinn  Yni1 minht have tha nntinn tn rin the annlicatinn cerver ac a cuctem coarvire deanandinn nn the nnaratinn
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___d. Continue through the panels accepting all the defaults by clicking on “Next” until you reach the
“Administrative Security” panel, then specify “wasadmin” for the user and “wasadmin” for the
password as shown below.

Choose whether to enable administrative security. To enable security, supply a user name and password for logging into administrative tools. This administrative user is
created in a repository within the application server. After profile creation finishes, you can add more users, groups, or external repositories.

Administrative Security

<cs

[V Enable administrative security
User name:

l wasadmin

Password:

Confirm password: [k

l LLLILI L]

___e. Again continue though all the panels accepting all the defaults by clicking “Next” until you reach the
panel shown below. Create the profile by clicking “Create”

ity Profile Management Tool 8.0

Profile Creation Summary ;

Review the information in the summary for correctness. If the information is correct, click Create to start creating a new
profile. Click Back to change values on the previous panels.

Application server environment to create: Application server
Location: /opt/IBM/WebSphere/AppServer/profiles/AppSrv0l
Disk space required: 200 MB

Profile name: AppSrv0l
Make this profile the default: True
Performance tuning setting: Standard

Node name: thinkNode01
Server name: serverl

Host name: think.ibm.com

Deploy the administrative console (recommended): True
Deploy the default application: True

Enable administrative security (recommended): True

Administrative console port: 9060

Adminictrativa rancnla cariira nart- QNAR

<_B_acl2\§U\C[eate Hyéncel ]
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__f. Unselect the “First Steps” dialog, click “Finish” as shown below

\‘# Profile Management Tool 8.0

Profile Creation Complete

<sss
/

The Profile Management Tool created the profile successfully.

=]

The next step is to decide whether to federate the application server into a deployment manager cell.
To federate the application server, use either the addNode command or the administrative console of the deployment

manager. Using the administrative console requires the application server to be running.

You can start and stop the application server from the command line or the First steps console. The First steps console also
has links to an installation verification test and other information and features that relate to the application server.

@unch the Flrs)steps console.

To start the Profile Management Tool later, use the PMT command in the app_server_root/bin/ProfileManagement directory or
the option in the First steps console.

___g. Exit the WebSphere Customization Toolbox (WCT) by clicking Exit as shown below

WebSphere Customization Toolbox 8.0

Window Help
o}
Exit (@Yoﬁle Management Tool] D Welcome

{®) Profiles | 5

‘ Profile name Environment Profile path \ liCreate...

7. Launch WebSphere Customization Toolbox (WCT) to Configure the HTTP Server Plugin
___a. As shown below change directories to /opt/IBM/WebSphere/Toolbox/WCT/ the enter ./wct.sh
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[= root@think:/opt/IBM/WebSphere/Toolbox/WCT [m}

File Edit View Terminal Tabs Help

root@think:/opt/IBM/WebSphere/AppServer/p... x Iroot@think:/optlIBMNVebSphere/Toolbox/WCT x
[root@think WCT]# cd

[root@think ~]# cd /opt/IBM/WebSphere/Toolbox/WCT/
[root@think WCT]# ./wct.shl

-

___b. Specify Web Server Plug-ins Configuration Tool and Click Launch Selected Tool as shown below

-c

Welcome to the WebSphere Customization Toolbox

Select a tool in the following list to display the welcome information for that tool. To launch a tool, select

a tool in the list, and click Launch Selected Tool. Alternatively, select Window > Open Perspective and
select a tool in the list.

List of provided tools:

Profile Management Tool (z/OS only)

ation Management Too

\Web Server Plug-ins Configuration Tool

L

LEaunch Selected TocD

Welcome information for selected tool

o

___c. Enter webserver1 and /opt/IBM/WebSphere/Plugins as shown below and click Finish
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Web Server Plug-ins Configuration Tool 8.0

Add Web Server Plug-in Location

Add a previously installed Web server plug-in location to your working set.

Web server plug-in location

Name: (S ]
f Location: [/opt/lBMNVebSphere/Plugins ] [B[owse...]

Cancel H Finish ]

___d. Click Create as shown below

) web Server Plug-in Configurations | €& Web Server Plug-in Response File =0

Web Server Definitic Web Server Typ Plug-in Configuration File ( {Qreate“.D
T — [

___e. Select IBM HTTP Server V8 and click Next
__f. Enter /opt/IBM/HTTPServer/conf/httpd.conf and click Next
___@. Create an userid ihsadmin with a password of ihsadmin as shown and click Next
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V#’ Web Server Plug-ins Configuration Tool 8.0

Setup IBM HTTP Server Administration Server }
x|

|

<<ss

Optionally configure an administrative server to administer the Web server. You can manage the Web server from a
WebSphere Application Server administrative console by using the IBM HTTP Server administrative server to control the
communication between them.

Setup IBM HTTP Server Administration Server

Specify a port number for IBM HTTP Server administation server to communicate. The default port is 8008. If the
default port is already in use, then change to another port that is available. Running IBM HTTP Server administation
server without root or Administrative privileges might restrict use of ports below 1024.

HTTP Administration Port:

8008

Optionally create a user ID and password to authenticate to the IBM HTTP Server Administation Server from the
WebSphere Application Server administrative console. The user ID and password is encrypted and stored in the cor
admin.passwd file. You can create additional user IDs after the configuration by using the htpasswd utility.

Create a user ID for IBM HTTP Server Administration Server authentication

User ID: [ihsadmin |
Password: [........ |
Confirm password: [........ ]

__h. Enter ihsrun and ihsgrp as shown and select “Create a new system user ID.......”, as shown below then
click Next

[ Web Server Plug-ins Configuration Tool 8.0

Setup IBM HTTP Server Administration Server

Specify a system user ID and group. The user ID is granted write access to IBM HTTP Server, IBM HTTP Serve
Administration Server and web server plug-in configuration files. If the user ID or group does not exist on the
then choose to create a new system user and group with the credentials.

User ID: [ihsrun |

Group: [ihsgrp |

——
@:a—r;;'unique system user ID and group using the credentials. -~

___i. Specify webserver1 for the web server name and click Next

___j- Checklocal and enter /opt/IBM/WebSphere/AppServer then click Next
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T APPILAUUIIS  Flaues  DySuen

Web Server Plug-ins Configuration Tool 8.0 x

Configuration Scenario Selection
| @

Configure the Web server plug-ins to the computer where the Web server exists. When the Web server and application
server are not on the same computer, choose the remote configuration scenario. When both Web server and
application server are on the same computer, choose the local configuration scenario. In the local scenario, the Web
server definition you create in this wizard is defined automatically in the application server.

<css

Configuration scenario

O (Remote) Host name or IP address of the application server

@ (Local) Installation location of WebSphere Application Server

Jopt/IBM/WebSphere/AppServer

For the remote configuration scenario, the host name must be accessible on the network through one of the following
address formats:

Fully qualified domain name system (DNS) host name
The default short DNS host name
Numeric IP address

___k. Select the AppSrvO01 profile and click Next

ielect the WebSphere Application Server profile to configure with the cumrent Web server plug-in and create the )
ierver definition.

\vailable Profiles:

AppSrv0l

___|. Click Configure, and then click Finish.
___m. Exit the WCT when complete

8. Configure WebSphere Application Server to use DB2.
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___a. DB2 is not running as a service, so you will need to start DB2 by opening a terminal window and
entering “su — db2inst1” which will change you from the user root to db2inst1 then enter the
command db2start as and wait for the message “SQL1063N DB2START processing was

successful” as shown below.

root@think:~

File Edit View Terminal Tabs Help

[root@think ~]# su - db2instl
-bash-3.2$ db2start
SQL1063N DB2START processing was successful.

-bash-3.2%

___b. Open a terminal window and change to the directory
opt/IBM/WebSphere/AppServer/profiles/AppSrv01/bin
___c. Start the server with the command “./startServer.sh server1” as shown below

root@think:/opt/IBM/WebSphere/AppServer/profiles/AppSrvOl/bin

File Edit View Terminal Tabs Help
[root@think ~]# cd /opt/IBM/WebSphere/AppServer/profiles/AppSrv01l/bin
[root@think bin]# ./startServer.sh serverl

ANMIIATTIAT - Tanl infarmatinn ic haina Tnnnad in fila

___d. Wait until you see the message

ADMU3000I: Server server1 open for e-business; process id is xxx

___e. Open a browser and enter the URL http://localhost:9060/ibm/console/

Note: If you receive a warning about the SSL certificate being presented click “Continue to the
website “to accept the certificate. This occurs because you are using a self-signed certificate from

WAS for which a certificate does not already exist in the browser

The warning below is from Internet Explorer, as an example, even though we are using Linux.
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[@ There is a problem with this website's security certificate.

The security certificate presented by this website was not issued by a trusted certificate
authority.
The security certificate presented by this website was issued for a different website's address.

Security certificate problems may indicate an attempt to fool you or intercept any data you
send to the server.

We recommend that you close this webpage and do not continue to this website.

© Click here to

% Continue to this website (not recommended).

The warning from Firefox is shown below

] This Connection is Untrusted

v A' You have asked Firefox to connect securely to 10.10.10.101:9043, but we can't confirm that your
connection is secure.

Normally, when you try to connect securely, sites will present trusted identification to prove that you
are going to the right place. However, this site's identity can't be verified.

What Should I Do?

If you usually connect to this site without problems, this error could mean that someone is trying to
impersonate the site, and you shouldn't continue.

Get me out of here!

Technical Details
I Understand the Risks

If you understand what's going on, you can tell Firefox to start trusting this site's identification. Even
if you trust the site, this error could mean that someone is tampering with your
connection.

Don't add an exception unless you know there's a good reason why this site doesn't use trusted
identification.

| Add Exception...

___f. Since WAS administrative security is enabled this will redirect to
https://localhost:904 3/ibm/console/login.do?action=secure Enter wasadmin for user ID and
wasadmin for the password as shown below
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WebSphere. EiVELC]

WebSphere Integrated
Solutions Console
User ID:
! ’wasadmin [
h Password:
|

[ceesenss
-

Licensed Materials - Property of IBM (c) Copyright IBM Corp. 1997, 2011 All
Rights Reserved. IBM, the IBM logo, ibm.com and WebSphere are trademarks or
registered trademarks of International Business Machines Corp., registered in
many jurisdictions worldwide. Other product and service names might be
trademarks of IBM or other companies. A current list of IBM trademarks is
available on the Web at Copyright and trademark information.

Note: When you open the browser you will receive one or two security alerts.

If prompted to remember passwords, DISABLE this function as shown the Windows Internet explorer
example below. Other browsers on different platforms will vary accordingly.

AutoComplete 5]

Do you want Windows to remember this password, so that you
. don't have to type it again the next time you visit this page?

v @on’t offer to remember any more passwords

2) WebSphere Integrated Solutions Consold
File Edit View History Bookmarks Tools Help

@ o v &G O f I@m https://think:9043/ibm/console/login.do?action=secure

/%) Do you want Firefox to remember the password for "wasadmin" on https://think:90437?

Password remembering functions can compromise security, so this function should not be used.
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___g. Once inside the console Navigate to Resources -> JDBC -> JDBC Providers ,Change the scope to
Node=thinkNode01 then select New

welcome
Guided Activities
Servers
Applications
Services
Resources
Schedulers
Object pool managers
# IMs
=l ipBeC
JDBC providers

Data sources

Data sources (WebSphere Application
Server V4)

# Resource Adapters
# Asynchronous beans
# Cache instances

# Mail

# URL

#l Resource Environment

Security

JDBC providers

JDBC providers

Use this page to edit properties of 2 JDBC provider. The JDBC provider object encapsulates the specific JDBC driver
implementation class for access to the speaflc vendor database of your environment. Learn more about this task in a

quided activity. A guided 3
=ll=thinkNode01Cell, Node=thinkNode01

[ node=thinkNodeo1

# Preferences

Scope specifies the level at which the resource definition
information on what scope is and how it works, see the sdope settings help.

a list of task steps and more general information about the topic.

visible. For detailed

ETEE)

‘Name < Scope

Description {

None

Total 0

___h. Click on JDBC Providers to start the dialog to create a DB2 JDBC Provider with the settings shown
below (note the resource scope of “thinkNode01”)

Create a new JDBC Provider

=> Step 1: Create new
JDBC provider

Step 2: Enter
database class path
information

Step 3: Summary

Create new JDBC provider

Set the basic configuration values of a JDBC provider, which encapsulates the specific
vendor JDBC driver implementation classes that are required to access the database.
The vizard fills in the name and the description fields, but you can type different values.

Scope
|cel|s:thin|r<Node01Cel| :nodes:thinkNodeO1 I

# Database type
ez [v]

# Provider type
| DB2 Universal JDBC Driver Provider [9

# Implementation type

| XA data source

* Name
|DBZ Universal JDBC Driver Provider (XA)

Description

Two-phase commit DB2 JCC provider that
supports JDBC 3.0. Data sources that use this
provider support the use of XA to perform 2-
phase commit processing. Use of driver type 2 on
the application server for 2/OS is not supported
for data sources created under this provider.
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___i. Configure the classpath to /Jopt/ibm/db2/V9.7/java and a native library path of
lopt/ibm/db2/V9.7/bin as shown

WebSphere Integrated Solutions Console - Mozilla Firefox

File Edit View History Bookmarks Tools Help

@ o v @ o @ [[o/ [N nttps:/ocalhost:9043/ibm/console/navigatorCmd.do?forwardName=|DBC '] [7:" @

[©] WebSphere Integrated Soluti... x

@ IBM WebSphere Hit CountD... X | % v

‘WehSphere. sof Help | Logout

B

database class path

[+ services variables that define the directory locations of the files. Use complete directory paths wh

JDBC driver file locations. For example: C:\SQLLIB\java on Windows(R) or fhome/db2inst1/

= Resxirces information Linux(TM).
Schedulers
Object pool managers Step 3: Summary Entries are separated by using the ENTER key and must not contain path separator charact
s ). If a value is speciﬁﬁi for you, you may click Next to accept the value.
[= JoBC
|DEdipoviders Class path:
Data sources

Data sources (WebSphere
Application Server V4)

${DB2UNIVERSAL_JDBC_DRIVER_PATH}/db2jcc jar
${UNIVERSAL_JDBC_DRIVER_PATH}/db2jcc_license_cu.jar

Resarce Adaprs ${DB2UNIVERSAL_JDBC_DRIVER_PATH}/db2jcc_license_cisuz.jar

[#] Asynchronous bears
Cache irstances
Mail

URL 3
1) R G Directory location for "db2jcc jar, db2jcc_license_cisuzjar" which is saved as WebSpherg
${DB2UNIVERSAL_JDBC_DRIVER_PATH} =
[roptiibm/db2/v9.7/java

Security

[= Environment

Virtual hosts

Update global Web server plug-in
configuration

Native library path

WebSphere variables

Directory location which is saved as WebSphere variable $ {DB2UNIVERSAL_JDBC_DRIVER
Shared libraries

[foptiibm/db2/v9.7/bin

SIP application routers

Replication domains

URI Groups

[ Naming Previous | Next | Cancel |

¥ 0SGi bundle repositories G Il [ D]
x Find: | 9 | <A Previous B Next - Highlightall []Match case
Done & .

___j. Click Next, Review the Summary Panel, then click Finish, then Save your changes.

___k. Click on the DB2 Universal JDBC Driver Provider (XA) as shown below.

Newl Delete

El=lE

Select‘ Name & Scope {5 Description

You can administer the following resources:

r DB2 Universal JDBC Driver Node=thinkNodeO1 Two-phase commit DB2 JCC
Provider ‘ ?! provider that supports JDBC

3.0, Data sources that use
this provider support the use
of XA to performn 2-phase

rammit nraceccinn. llee af

___|. Click on Data sources as shown below
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JDBC providers > DB2 Universal JDBC Driver Provider (XA)

Use this page to edit properties of a Java Database Connectivity (JDBC) provider, The JDBC
provider object encapsulates the specific JDBC driver implermentation class for access to the
specific vendor database of your environment.

Configuration

General Properties

Additional Properties

* Scope _—
|ce||s:thinkCel|01:n0des:thinkNodeDi I ﬁ%
Data Sources

F Name

. (WebSphere

___m. Configure a Data source with following settings
1) DataSource Name  WAS V8 Datasource for DB2

2) JNDI Name jdbc/WAS97DB_DS
3) Database Name WAS97DB

4) Server name think

5) Port 50000

6) the settings shown below, and Save

Create a data source -

Create 2 data source

Step 1: Enter basic Summary
data source
information Summary of actions:
Step 2: Enter Options Values
database specific
properties for the Scope cells:thinkNode0O1Cell:nodes:thinkNode01
e Data source name WAS V8 Datasource for DB2
Step 3: Setup JNDI name jdbc/WASS7DE_DS
security aliases
Select an existing JDBC provider DB2 Universal JDBC Driver Provider (XA)
= Step 4: Summary Implementation class name com.ibm.db2.jcc.DB2XADataSource
Driver type 4
Database name WASS7DB
Server name think
Port number 50000
Use this data source in contziner managed persistence (CMP) true
Authentication alias for XA recovery (none)
Component-managed authentication zlias (none)
Mapping-configuration alias (none)
Container-managed authentication alias (none)
Previous Finish Cancel

___n. After configuring the Data source you will need to create a JAAS—J2C Authentication Alias. Select the
data source you just configured, then the JAAS-J2C authentication data by clicking as shown
below.
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Test connection

General Properties

# Scope

cells:thinkNode01Cell:nodes:thinkNode01 |

# Provider

[DB2 Universal JDBC Driver Provider (XA) |

* Name
|WAS V8 Datasource for DB2

JNDI name
[idbe/wass7DE_DS

Use this data source in contziner managed persistence (CMP)

Description
DB2 Universal Driver Datasource

IBM Proof of Technology

Additional Properties

Connection pool properties

WebSphere Application Server data source properties

Custom properties

Related Items

JAAS - J2C authentication data_)

___ 0. Select New and create an alias with the name db2alias, the user ID of db2inst1 and password of
password as shown below, then click OK. Then Save the changes.

Specifies a list of user identities and passwords for Java(l

General Properties

#* Alias
[db2alias

# User ID
[db2inst1

* Password

Description

|App|y|£, Resetl Cancel I

___p. Navigate to the data source, and change the security settings to use a container-managed

authentication alias, using the alias you just created. Select db2alias from the drop-down list as

shown in the following screenshot

Lab 1
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Security settings
Select the authentication values for this resource.

Authentication alias for XA recovery
I (none) ‘ZI

Component-managed authentication alias
I (none) E'

Mapping-configuration alias
l(none) [Zl

ontainer-managed authentication 3
{thinkNode01/db2alias! v |

..............................................................

[Select the authentication values for this resource. |

Common and required data source properties

Name Value

* Driver type

# Database name |wasvs7DE
* Server name |think

# Port number |50000

___ Q. Select OK. Save your configuration by clicking Save

E Messages

&Changes have been made to your local configuration. You
can:

® Save directly to the master configuration,

® Review changes before saving or discarding.

O The server rmay need to be restarted for these changes to
take effect.

___r. Change the data source mapping for the Default Application

___s. Navigate to Applications -> Application Types -> WebSphere Enterprise Applications

___t. Stop the Default Application

___u. Click on the application DefaultApplication to drill down into the application settings as shown below
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Enterprise Applications
Use this page to manage installed applications. A single application can be deployed onto multiple servers.

Preferences

Startl Stopl Install Uninstall Update Rollout Update Remove File I Export | Export DDL Export File

Select Name Application Status Q

You can administer the following resources:

r DefaultAgEIication ®

r ivtApp P
| auery P
Total 3

___v. Then click on “Map data sources for all 2.x CMP beans” as shown below to drill down into the
current application settings

Enterprise Applications 7=

Enterprise Applications > DefaultApplication

Use this page to configure an enterprise application. Click the links to access pages for further
configuring of the application or its modules,

Configuration

General Properties

Modules
* Name - Modul

=f 5 2 icati Manage Modules
ID':F-:‘Jlt"‘.pplll_dtll:lrl | sonnn e i
Application reference validation Web Module Properties

Issue warnings
I ng ;I Session management
Detail Properties Context Root For Web Modules

JSP and JSF options

Target specific application
status Virtual hosts

Startup behavior Enterprise Java Bean Properties

Application binaries

Default messaging provider
references

Class loading and update
detection

Request dispatcher properties

Security role to user/group
mappin

View Deployrment Descriptor

rmapping for modules containing 2.x

Last participant support entity beans
extension EJB JNDI names
References

Database Profiles
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___w. Change the Data Source settings as described below
1) Browse to jdbc/WAS97DB_DS as the target resource JNDI name, and select Apply
2) Select the Increment EJB and click Set Authorization Type, specify Container for the
Authorization Type
3) Click OK

Enterprise Applications > DefaultApplication > Map data sources for all 2.x CMP beans

Map data sources for all 2.x CMP beans

Specify an optional data source for each 2.x container-managed persistence (CMP) bean. Mapping a specific data source to a CMP
bean overrides the default data source for the module that contains the enterprise bean.

Set Multiple JNDI Names ~ | | Set Authorization Type ~ | Modify Resource Authentication Method...
Ct&tainer
3
Select EJB EJB rmodule URI o=t Resource JNDI Nagye Resource authorization

Resource
authorization:

Per application

[idbe/wasv7De_DS

Browse...

Increment EJB Increment.jar, META-INF/ejb-
rmodule jar.xml

M Cancel

4) Select the Increment EJB and click Modify Resource Authentication Method
5) Select Use default method and browse to db2alias as the Authentication data entry
6) Click Apply

Dean overriges tne Jderault gata source Tor tTne Modgulie TNat contains tTne enterprise pean.
Set Multiple JNDI Names ~ Set Authorization Type ~ ] v Resource Authenticat] thod...

ecify authentication method:

C None

@ Use default method (many-to-one mapping

Authentication data entry

" Use trusted connections (one-to-one mapping)

" Use custorn login configuration

:

Select EJB EJE module URI Target Resource JNDI Name Resource authorization
Resource
authorization:

gcrermnent EJB Increment.jar, META-INF/ ejb- bddeASV7DS—DS Container
odule jar.xml Browse... Authentication
method:
MNone

___X. Verify the settings indicated below and click OK

Page 42 Installation and Configuration



IBM Software

the default data source for the module that contains the enterprise bean.

IBM Proof of Technology

Set Multiple JNDI Names ~ Set Authorization Type ~ Modify Resource Authentication Method...
Select| Bean Module URI Target Resource JNDI Name esource authoriza’

Increment EJB Increment.jar, META-INF/ejb- i'ddeASV97DB_DS

E] Increment =
module jar.xml Brovse...

EI Cancel

___y. Save your changes.
___z. Start the DefaultApplication

___aa. Open Firefox with the url http://localhost:9080/hitcount and select “Enterprise Java Bean (CMP)

as the execution method and click on “Increment” as shown below

| ¥)18BM WebSphere Hit Count Demonstration - Mozilla Firefox
File Edit View History Bookmarks Tools Help

2
Resource authorization:

Container

Authentication method:
DefaultPrincipalMapping
Authentication data
entry:

thinkNode01/db2alias

- c (R Il—] ‘http:h’localhost:9080Ihitcount

2 Most Yisited ’ Getting Started - Latest Headlines

Hit Count Demonstration

Select a method of execution:
" Servlet instance variable
" Session state (create if necessary)
" Existing session state only

Namespace lookup method for EJB:
 Global Namespace ¢ Local Namespace

Transaction type:
T None ¢ Commit © Rollback

Increm%t |

Please select a method of execution above.

This simple demonstration provides a variety of methods to increment a counter value.

”

___bb. If you have successfully configured the datasource to use DB2 you’ll see the value increment as

shown below on each reload of the page
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|2 Most Visited P Getting Started . | Latest Headlines

Hit Count Demonstration

This simple demonstration provides a variety of methods to increment a counter value.

Select a method of execution:
" Servlet instance variable
" Session state (create if necessary)
" Existing session state only
" Enterprise Java Bean (CMP)

Namespace lookup method for EJB:
" Global Namespace ¢ Local Namespace

Transaction type:
T None ¢ Commit ¢ Rollback

Increment t

Hit Count value for (Increment EJB): 1

9. Configure IBM HTTP Server for use with WAS

___a. Start the IBM HTTP Server as shown below

root@think:/opt/IBM/HTTPServer/bin =0
File Edit View Terminal Tabs Help

[root@think bin]# cd /opt/IBM/HTTPServer/bin
[root@think bin]# ./apachectl start
[root@think bin]# |

___b. Test that IHS is running by entering http://localhost as shown below

sl
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[BR nhttp://10.10.10.101/

4 |5/ Latest Headlines || IBM

[+]

WebSphere. software

IBM HTTP Server version 8.0

& | @Information & | Bl Release

Administration center Support notes

___c.Inthe ISC navigate to Servers -> Server Types -> Web Servers

B servers
B server Types
WebSphere application servers
WebSphere MQ servers

Web servers

___d. Note that webserver1 was created using the WebSphere Customization Toolkit earlier. Now that the
webserver is created generate and propagate the plugin configuration file as shown below
1) Select the web server (1), and then click Generate Plug-in (2),
2) Select the web server (1), and then click Propagate Plug-in (3).
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Web servers

Use this page to view z list of the installed web servers.

Delete Templates... Start Stop
Select Name 2 | Web server Type { _ Node {5 _ Host Name |
You can administer the following resources:
viebserverl 1 IBM HTTP Server thinkNodeO1 think.ibm.com

e. Go to Firefox and enter http://localhost/hitcount. Exercise the application as before selecting
“Enterprise Java Bean” and clicking Increment

%318BM WebSphere Hit Count Demonstration - Mozilla Firefox o [=] P}
File Edit Yiew History Bookmarks Tools Help
v c N Y I \_] | http:flocalhost hitcount w T I ~ | Google />

&; Most Visited ’ Getting Started - Latest Headlines

Hit Count Demonstration

This simple demonstration provides a variety of methods to increment a counter value.

Select a method of execution:
" Servlet instance variable
" Session state (create if necessary)
" Existing session state only
" Enterprise Java Bean (CMP)

Namespace lookup method for EJB:
C Global Namespace ¢ Local Namespace

Transaction type:
C None © Commit © Rollback

Increment |

Please select a method of execution above.

___f. You may also want to invoke http://localhost/snoop and examine the results. You can see that the
HTTP server is being used as well as the port (9080) in use in the WebSphere web container among

other runtime configuration details.
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10. Configure WebSphere Application Server to use an LDAP as a user registry. OpenLDAP has been
installed and configured with a small user user population on the lab image.

___a. Navigate to Security in the ISC and click Global Security as shown below.

Integrated Solutions Console

Welcome wa:s

View: IAII tasks

=l

Welcome
Guided Activities
Servers
Applications
Services
Resources

B security

Global security
Security domaNys

Administrative Authorization Groups

SSL certificate and key management

Security auditing

Bus security

___b. On the Global Security dialog, click Configure as shown below

Global security

Use this panel to configure administration and the default application security policy, This security configuration applies to the security polic
functions and is used as a default security policy for user applications, Security domains can be defined to override and customize the secu

applications.

I Security Configuration Wizard

Security Configuration Report

Administrative security

¥ Enable administrative security

Administrative user roles

Administrative group roles
Administrative authentication

Application security

™ Enable application security

Java 2 security

l_ Use Java 2 security to restrict application access to local resources

™ warn if applications are granted custormn permissions

7 Restrict access to resource authentication data

User account repository
Current realm definition
Federated repositories

Available realm definitions

IFederated repositories = Confipyre... |
RS

Set as current

|

Authentication
Authentication mechanisms and expiration

& LTpa

" Kerberos and LTPA

(This function is currently disabled. See the IBM Supp:
possible future updates.)

Kerberos confiquration
C swam (deprecated): No authenticated communication
Authentication cache settings
Web and SIP security
RMI/IIOP security

Java Authentication and Authorization Service

[ use realm-qualified user names

Security domains
External authorization providers
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___c. Click Add Base Entry to Realm as shown below

Cell=thinkNode01Cell, Profile=AppSrv01
Global security 4

Global security > Federated repositories

By federating repositories, identities stored in multiple repositories can be managed in a single,
virtual realm. The realm can consist of identities in the file-based repository that is built into the
system, in one or more external repositories, or in both the built-in repository and one or more
external repositories,

General Properties

# Realm name
|defaultwIMFileBasedRealm

# Primary administrative user name
[wasadmin

Server user identity

« Automatically generated server identity

 server identity that is stored in the repository

v Ignore case for authorization

Repositories in the realm:

| Add Base entfy to Realm... | Use built-in repository Remove
L2\
Select Base Entry

Repository Identifier Repository Type
You can administer the following resources:

r o=defaultWIMFileBasedRealmn InternalFileRepository File

___d. Click Add Repository, select LDAP Server from the drop down.

Global security W E

Global security > Federated repositories > Repository reference

Specifies a set of identity entries in a repository that are referenced by a base entry into the
directory information tree. If multiple repositories are included in the same realm, it might be
necessary to define an additional distinguished name that uniquely identifies this set of entries
within the realm.

General Properties

# Repositor

none definediid

| Add Rppository... |
)

# Distinguished name of a base entry that uniquely identifies this set of entries in the realm

Distinguished narme of a base entry in this repository

l
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___e. Enter LDAP for the Repository Identifier, Custom for the Directory Type and think for the Primary
Host Name, and 389 for the port as shown below and click Apply then click on Group Attribute

Definition as shown below.

Note: Until you click Apply the Group Attribute Definition is not accessible. If you accidentally click OK
instead of Apply, you end up on the Manage Repositories panel. To return panel shown below simply “drill
down” into LDAP repository from the Manage Repositories panel

#* Repository identifier

LDAP

LDAP server

# Directory type

Security

Bind distinguished name

ICustom ;I I
# Primary host name Port Bind password
[think 389 I

Failover server used when primary is not available:

Select Failover Host Name Port

None

Add| |

Support referrals to other LDAP servers
I ignore v I

Additional Properties

Performance

LDAP entity types
Group attribute definition

Login properties
Iuid

LDAP attribute for Kerberos principal name

Certificate mapping
| EXACT_DN -

Certificate filter

l

I_ Require SSL communications

« Centrally managed

Manage endpoint security configurations

 Use specific S5L alias
INode[‘efau\t‘EHE-L‘E-efﬁ\rwg:;‘

SSL configurations

| |

___f. Enter guid for the Name of the group membership attribute as shown below and click OK , then

Save your changes
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Global security > Federated repositories > Repository reference > LDAP > Group attribute definition

Use this page to specify the name of the group membership attribute, Every Lightweight Directory Access Protocol (LDAP) entry
includes this attribute to indicate the groups to which this entry belongs.

General Properties Additional Properties

Narne of group membership attribute
|guid

Member attributes

Dynamic member

Scope of group membership attribute attributes

@ Diract - Contains only immediate members of the group without members of subgroups
" Nested - Contains direct members and members nested within subgroups of this group

" All - Contains all direct, nested, and dynamic members

___g. Navigate back to Global Security -> Federated repository - > configure. Click Add Base entry to
Realm again. Enter o=LDAP for Distinguished name of the base entry for the realm and
dc=ibm,dc=com for the Distinguished name of the base entry for this repository and click OK as
shown below, then Save your changes

Global security > Federated repositories > Repository reference

Specifies a set of identity entries in a repository that are referenced by a base entry into the
directory information tree, If multiple repositories are included in the same realm, it might be
necessary to define an additional distinguished nare that uniquely identifies this set of entries
within the realm,

General Properties

# Repository

ILDAP;I I Add Repository... I

# Distinguished name of a base entry that uniquely identifies this set of entries in the realm
[o=LDAP

Distinguished narme of a base entry in this repository
Idc=ibm,dc=com|

Applyl%g Resetl Cancel

___h. As shown below on the Global Security Panel
1) Click Set as current,
2) Click Apply
3) Select Enable Application Security
4) Click Apply
5) Then Save your changes
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Global security

Use this panel to configure administration and the default application security policy, This security configuration applies to the secu
functions and is used as a default security policy for user applications. Security domains can be defined to override and customize 1
applications.

| Security Configuration Wizard ] Security Configuration Report

Administrative security Authentication

Administrative user roles Authentication mechanisms and expiration
Administrative qroup roles
Administrative authentication

¥V Enable administrative security

& Ltpa

" Kerberos and LTPA

Application security (This function is currently disabled. See the II
possible future updates.)

V' Enabl licati it 3
nable application security v Kerberos configuration

T gwam (deprecated): Mo authenticated cormnrmu

Authentication cache settings

Java 2 security

r Use Java 2 security to restrict application access to local resources

[T warn if applications are granted custorn perrissions Web and SIP security

r Restrict access to resource authentication data RMI/IIOP security

. Java Authentication and Authorization Service
User account repository

Current realm definition 7 use realm-qualified user names

Federated repositories

Available realm definitions 1 . .
= Security domains
IFederated repositories Ll Configure... Set ag current l External authorization providers
l’% Custom properties

2 4
Apply Reset

___i. In order for the changes to be reflected you will need to stop and start the server.
1) Logout from the ISC
2) Stop the server from the terminal window you started it in with the command

IstopServer.sh server1 —username wasadmin —password wasadmin
3) Wait until you see the message
ADMU4000I: Server server1 stop completed.

4) Start the server from the LINUX shell with the command ./startServer.sh server1

___j. Once the server has started, log back into the ISC and navigate to Users and Groups and click
Manage Users as shown below
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View: All tasks

v]

Welcome

[+ Servers

[+ Applications
[+ Services

[+] Resources
[+ Security

(+/ Environment

[+ Guided Activities

[+ System administration

il=] Users and Grou

psi

Administrati

Administrati

ve user roles

ve group roles

ge =

<

Manage Groups

___k.Inthe Seach for Users dialog click Search as shown below. You should see the user entries from
LDAP as well as for wasadmin in the file-based registry.

anage Users

Search for Users

Search by *Search for

*Maxirnurn results

IUser 10 ;l |*

100

10 users matched the search criteria,

I Create... | | Delete “Select an action...

Select User ID

[T idoei

O(a|oga|oa|oa|a

wasadmin

Page 1 of 1

First name

John Doel

John Doe2

John Doe3

John Doed

John DoeS

John Doeé

John Doe?

John Doesg

John Doe9

wasadmin

Last name E-mail
Doel
Doe2
Doe3
Doed
DoeS
Doeé
Doe7
Does8
Doe9

wasadmin

=l =1 [

Unique Mame
uid=jdoel,ou=user,0=LDAP
uid=jdoe2,0u=user,0=LDAP
uid=jdoe3,ou=user,0=LDAP
uid=jdoed4,ou=user,0=LDAP
uid=jdoeS,ou=user,0=LDAP
uid=jdoeé,ou=user,0=LDAP
uid=jdoe?,ou=user,0=LDAP
uid=jdoe8,ou=user,0=LDAP
uid=jdoe9,ou=user,0=LDAP

uid=wasadmin,o=defaultWIMFileBasedRealm

Total: 10
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___|. Open Konqueror and enter the URL http://localhost/snoop you should be prompted for a User name
and password as shown below, enter jdoe1 for the User name and jdoe1 for the password

File Edit View History Bookmarks Tools Help

- x B I Nhttp:ﬂlocalhost,fsnoop > - ' Google

|2 | Most Visited ’ Getting Started . Latest Headlines

Authentication Required x|

e A username and password are being requested by http:fflocalhost. The site says: "Default Realm"

User Name: I jdoet

Password: I Y|

N Conce

Congratulations, your application infrastructure is now ready to serve applications through the HTTP server ->
HTTP server plug-in -> WebSphere Application Server -> DB2.

Before starting the next part 2 of the lab (below) first

1) Log out of the ISC

2) Stop WebSphere Application Server by entering

IstopServer.sh server1 —username wasadmin —password wasadmin
from the LINUX command window where you started the application server.
Once you see the message

ADMU4000I: Server server1 stop completed.

You’re ready to proceed to part 1.6
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1.6 Adding Clustering to the Departmental Deployment

11. Create the Deployment Manager profile

___a. Start the graphical Profile Management Tool (PMT) with the command ./pmt.sh from a terminal shell
in the directory /opt/IBM/WebSphere/AppServer/bin/ProfileManagement

root@think:/opt/IBM/WebSphere/AppServer/bin/ProfileManagement

Ell=1ES
File Edit View Terminal Tabs Help

[root@think ProfileManagement]# cd /opt/IBM/WebSphere/AppServer/bin/ProfileManag
ement/
[root@think ProfileManagement]# ./pmt.sh

___b. Click Create

___c. Highlight Management as the Environment Selection as shown below, then click Next

# Profile Management Tool 8.0
Environment Selection 'j (
=|(
Select a specific type of environment to create.
Environments:

¥ WebSphere Application Server
Cell (deployment manager and a federated application server)

Application server

Custom profile

Secure proxy (configuration-only)

___d. Select Deployment Manager as shown below, then click Next
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I Profile Management Tool 8.0 q
Server Type Selection [
J /é

Select the type of server to be created within this management profile —

(O Administrative agent

An administrative agent provides management capability for multiple stand-alone application servers. An
administrative agent can manage only the application servers that exist within the same installation on one machine.

@ Deployment manager

A deployment manager provides management capability for multiple federated nodes. A deployment manager can
manage nodes that span multiple systems and platforms. The nodes that are managed by a deployment manager
can only be managed by a single deployment manager and must be federated to the cell of that deployment
manager.

___e.Asyoudid in part 1, select Advanced Profile Creation on the next panel, then click Next
___f. Accept the defaults, clicking Next, until you get to the Administrative Security Panel, then once again
enter “wasadmin” for the user ID and “wasadmin” for the password.

Administrative Security

<<<s

Choose whether to enable administrative security. To enable security, supply a user name and password for logging into administrative tools. This administrative user is
created in a repository within the application server. After profile creation finishes, you can add more users, groups, or external repositories,

[V Enable administrative security
User name:

| wasadmin

Password:

Confirm password: [k

___g. Continue to accept the PMT provide defaults until you reach the Port Value Assignment panel shown
below, select Default Port Values (we’ll take steps to insure no conflicts exist).

Lab 1 Page 55



Discovering the value of IBM WebSphere Application Server V8.0 for Administrator

e

Profile Management Tool 8.0 M=%

Port Values Assignment v é

The values in the following fields define the ports for the deployment manager and do not conflict with other profiles in this installation. A

Another installation of WebSphere Application Server or other programs might use the same ports. To avoid run-time port conflicts, verify
that each port value is unique.

Default Port Values] [Becommended Port Values]

Administrative console port (Default 9060): 2061 =
Administrative console secure port (Default 9043): 9044 (=
Bootstrap port (Default 9809): 9809 5
SOAP connector port (Default 8879): 8879 =

Administrative interprocess communication port (Default 9632)(X): | 9632

<>

SAS SSL ServerAuth port (Default 9401): 9408 |2
CSIV2 ServerAuth listener port (Default 9403): 9407 |2
CSIV2 MultiAuth listener port (Default 9402): 9409 (2
ORB listener port (Default 9100): 9101 |2
Cell discovery port (Default 7277)(6): 7277 =

High availability manager communication (DCS) port (Default 9352): | 9352

___h. As before in Part 1 when configuring the application server do NOT select “Run the deployment
manager process as a Linux service” , and click Next

___i. Click Create to create the profile,

___j-Unselect “First Steps” then click Finish.

___ k. Exit the PMT as you did in part 1 by selecting File -> Exit in the upper left corner of the PMT

l.
___12. Start the Deployment Manager

___a. Open a LINUX command shell and navigate to
lopt/IBM/WebSphere/AppServer/profiles/IDmgr01/bin

___b. Enter the command ./startManager.sh and wait until you see the message

ADMU3000I: Server dmgr open for e-business; process id is xxxx

____13. Federate the Application Server
___a. Return to the LINUX command shell that you used to start and stop the Application Server (if you
closed the shell the directory is lopt/IBM/WebSphere/AppServer/profiles/AppSrv01/bin)
___b. Enter the command

.JaddNode.sh localhost —includeapps —username wasadmin —password wasadmin
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This tells WAS to add a node by connecting to the deployment manager running on the localhost, to
include the existing applications that are deployed on the application server and to use wasadmin as
the administrative userid and password.

___c¢. Wait for the message ADMU0003I: Node thinkNode01 has been successfully federated

14, Configure a WAS-ND Cluster
___a. Log into the ISC using FireFox, with the URL http://localhost:9060/ibm/console/. Since WAS
administrative security is enabled this will redirect to
https://localhost:904 3/ibm/console/login.do?action=secure Enter “wasadmin” for user ID and
password as you did before.
___b. Navigate to Servers -> Clusters and click WebSphere Application Server clusters in the console

as shown below.

I View: |AII tasks

Welcome
Guided Activities

Bl servers
New server
B server Types
WebSphere application servers
WebSphere proxy servers
Generic servers
Version 5 JMS servers
WebSphere MQ servers

Web servers

Bl Clusters
WebSphere application server
clusters
Proxy server clusters
Generic server clusters

Cluster topology

___c. Click New to create a new cluster
___d. Enter MyCluster for a Cluster name as shown below, then click Next

Create a new cluster

Create a new cluster

—3 Step 1: Enter basic
cluster information

Step 2: Create first
cluster member

Step 3: Create
additional cluster
members

Step 4: Summary

Cancel |

Enter basic cluster information

# Cluster name
|MyCIusted

IV prefer local, Specifies whether enterprise bean requests will
be routed to the node on which the client resides when possible,

r Configure HTTP session rmemory-to-merory replication

___e. In order to use our existing server configuration and application we are going to select create the
cluster member by converting an existing application server as shown below, then click Next

Lab 1

Page 57



Discovering the value of IBM WebSphere Application Server V8.0 for Administrator

Create a new cluster

Step 1: Enter basic Create first cluster member

cluster information

The first cluster member determines the server settings for the cluster members. A
server configuration template is created from the first member and stored as part of
the cluster data. Additional cluster members are copied from this template.

Step 2: Create first
cluster member

Step 3: Create # Member name
additional cluster |

members ==l |
Step 4: Summary Select node
thinkNodeO1(ND 8.0.0.0)
* Weight
[2 | (0..20)

Generate unique HTTP ports

Select how the server resources are promoted in the cluster.

Select basis for first cluster member:

O Create the member using an application server template.
default

O Create the member using an existing application server as a template.

thinkCell01/thinkNodeO1(ND 8.0.0.0)/serverl

@ Create the member by converting an existing application server.

[ thinkcCello1/thinkNode01(ND £.0.0.0)/serverl

O None. Create an empty cluster.

| Previous ”Next” Cancel I

__f. Enter server2 as the server name for the next cluster member as shown below and click Add
Member. Then enter server3 as a server name and click Add Member. At this point you should
have 3 servers in the cluster; server1, server2 and server3. Once you do so, click Next
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Create a new cluster ?

Create a new cluster

Step 1: Enter basic
cluster information

Step 2: Create first
cluster member

Create additional cluster members

Enter information about this new cluster member, and click Add Member to add this
cluster member to the member list. A server configuration template is created from
the first member, and stored as part of the cluster data. Additional cluster members

are copied from this template.

Step 3: Create

additional cluster # Member name
members |server2 ‘
Step 4: Summary Select node
[ thinkNode01(ND £.0.0.0) [v]
#* Weight
[2 | (0..20)

Generate unigue HTTP ports

or remove the first cluster member.

Use the Edit function to modify the properties of a cluster member in this list. Use the
Delete function to remove a cluster member from this list. You are not allowed to edit

B @D

Select | Member name Nodes Version

Weight

serverl thinkNode01 ND 8.0.0.0

Total 1

___ 9. Review the settings, then click Finish to create the cluster members

___h. Now navigate to Servers -> Server Types -> WebSphere Application Servers, select server1 and

click delete

Note: Server1 is being deleted to remove the port conflicts were mentioned previously during
profile creation. Alternatively one could have changed the port number settings for server1, but
simply removing the server from our configuration is the quickest means remove the conflicts.

___i. You can choose to save your changes at this time if you wish, but we have one more configuration
change to make, this to the virtual host definition. Navigate to Environment -> Virtual Hosts in the

console

B Environment

Virtual hosts

Update global Web server plug-in
configuration

WebSphere variables
Shared libraries
Replication domains
URI Groups

Naming
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__j. Click default_host

prtwalbosts |

Virtual Hosts

Use this page to create a virtual host vith 2 unique set of web acce
virtual host has a logical name and a list of one or more domain n

+ Preferences
Newvs... Delete
EEEE
Select Name &

You can administer the folloving resources:

D admin host
O default host

Total 2

___ k. Check to insure that numbers 9081 and 9444 (for server 2) as well as ports 9082 and 9445 (for
server3) exist for the host alias list for the default host. Add them if needed (they should already be

listed) Click Save if you need to add them

Virtual Hosts > default host > Host Aliases

Use this page to edit, create, or delete a domain name systerm (DNS) alias by which the
virtual host is known,

Preferences

New | Delete

el

Select Host Name

You can administer the following resources:

-

aa|aa(oa|ajo|n

r

v

*

#

1% | 1% | 1% 1% | 1*| |*| |*

| %

Total 10

Port £

443
5060
s061
80
9080
9081
9082
9443
9444

9445
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___|. Save your changes if you’'ve not already done so
___m. Just to make sure all our changes have been pushed out to the node agent, we’re going to save and
synchronize as shown below.

View: IAII tasks ~
Welcome Save 7= E
Guided Activities Save 1
]
Servers Save your workspace changes to the master configuration. <
Applications Click Save to update the master repository with your changes. Click Discard to discard :
your changes and begin work again using the master repository configuration. Click
Services Cancel to continue working with your changes,

Resources

[P

Total changed documents: 0
Security

=
& Environment v Synchronize changes with Nodes

E system administration

| Save I Discard Cancel

ve changes to master yepository

D
.

yeployment manager
tomda

___n. Once the synchronization is complete, you will need to regenerate and propagate the HTTP server
plug-in as you did before by navigating to Servers —> Web Servers, selecting webserver1 and
clicking Generate Plug-in and then once again selecting webserver1 and clicking Propagate Plug-
in

0. You can now start your application server cluster by navigating to; Servers -> Clusters ->
WebSphere Application Server Clusters, selecting MyCluster and clicking start. Once the cluster
is completed starting as shown below, you can enter http://localhost/snoop in a Konqueror browser
instance and if you examine it's output you’ll see that some requests are served from port 9081
(server2) and some from port 9082 (server3).

WebSphere application server clusters

Use this page to change the configuration settings for a cluster. A server cluster consists
of a group of application servers. If one of the member servers fails, requests will be
routed to other members of the cluster. Learn more about this task in a quided activity.
A guided activity provides a list of task steps and more general information about the
topic,

Preferences

Newl Deletel Startl Stopl Ripplestart ImmediateStop I
RS .
Select MNarme £ Status ()

You can administer the following resources:

r MyCluster =

Total 1

Note: You may have noticed that you were not prompted to login when you accessed the application,
this is because the Global Security settings a standalone WAS instance is not migrated during
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federation into a WAS-ND cell. You could repeat step 6 from part 1 if required. You can leave the
Dmgr and Application Servers running, as they are required for Lab #2.

(optional) Take a VM snapshot (to insure you have a recovery point). As before provide a meaningful name
such as “ Lab 1 End”

B 2011 T3 v3 - VMware Workstation

File Edit View | Team Windows Help
il ? Power »
‘*‘ @ Removable Devices 4
&} . Pause Shift+Ctrl+P

@) Applications

I Change deskto|  Snapshot »  Take Snapshot...
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Common Tasks

Below are some common tasks that you may need to perform several times during this lab

15, Starting a WAS (standalone) application server ./startServer.sh <servername>
e.g from the /opt/IBM/WebSphere/AppServer/profiles/AppSrv01/bin directory
IstartServer.sh server1

______16. Stopping a WAS (standalone) application server ./stopServer.sh <servername>
e.g from the /opt/IBM/WebSphere/AppServer/profiles/AppSrv01/bin directory
IstopServer.sh server1

____17. Starting a WAS-ND Node Agent startNode.sh
e.g from the /opt/IBM/WebSphere/AppServer/profiles/AppSrv01/bin directory
startNode.sh

____18. Stopping WAS-ND Node Agent stopNode.sh
e.g from the /opt/IBM/WebSphere/AppServer/profiles/AppSrv01/bin directory
stopNode .sh

_____19. Starting a WAS-ND Deployment Manager startManager.sh
e.g from the /opt/IBM/WebSphere/AppServer/profiles/Dmgr01/bin directory
startManager.sh

___20. Starting a WAS-ND Deployment Manager stopManager.sh
e.g from the /opt/IBM/WebSphere/AppServer/profiles/Dmgr01/bin directory
stopManager.sh

21. Mounting CDs in VMware
___a. As shown below navigate to VM -> Removable Devices -> CD-ROM (IDE1:0) -> Edit

Lab 1 Page 63



Discovering the value of IBM WebSphere Application Server V8.0 for Administrator

| | Team Windows Help

» b= (=)

Power
Removable Devices » v Audio (Auto detect) »
CD-ROM 1:0 » Connect
u Snapshot » L= El
v Ethernet >
Replay »
Clone... USB Devices

Install VMware Tools...

___b. As shown below in In the CD-ROM (IDE:1.0) panel

1) Click Browse
2) Select the ISO image desired

3) Click Open
4) Check Connected
5) Click OK
CD-ROM (IDE 1:0) X
Device status
[¥] Connected 4
[[] Connect at poweron
Connection
(O Use physical drive:
. usivel ual machine Browse for ISO Image m
Lookin: | £ WAS7STEW-working ¥ © 2 @
(®) Use 1SO image: 1 -
- r |_)Presentations
‘C:\iemp\WAS7STEWwork|ng\v«| [ Browse... &E) (5 was.cd. 7000.isaagent.linux.ia32.iso
My Recent (® was.cd. 7000.isawb.windows.ia32.iso
Documents | | was.cd. 7000.nd.windows.ia32.is0: 2
= @was.cd.7000.supplemens.nd.windows.ia32.iso
E
Desktop
5 [Advanced...
ok [ Comos J[_Fep =/
My Documents
3
My Computer
3
" File name: ‘was.cd.70004nd4windows.ia32.iso |z| I [Qpen l
1 A
My Network | Files of type: ‘CD-ROM images ("iso) |Z| [ Cancel ]

Page 64

Installation and Configuration



IBM Software IBM Proof of Technology

I This page is left intentionally blank. I

Lab 1 Page 65



Discovering the value of IBM WebSphere Application Server V8.0 for Administrator

I This page is left intentionally blank. I

Page 66 Installation and Configuration



IBM Software
WebSphere

Administering an OSGi Application with WAS v8
Lab Exercise 2




Administering OSGi applications with WAS V8

Lab 2

© Copyright IBM Corporation, 2011

US Government Users Restricted Rights - Use, duplication or disclosure restricted by GSA ADP Schedule Contract with IBM Corp.



IBM Software

Contents
ADMINISTERING AN OSGI APPLICATION WITH WAS V8 ... iiiciietrimrna s s snnm s snmmsnammrnmmnmmenes 1
BEFORE YOU BEGIN ... i i i recrea s sme s saessaamssansrasmssasnrasnsassnsssmnsssnnssnmnannnssnmssnnmsannrnnns 4
ABOUT THE APPLICATION YOU WILL DEPLOY ..ot ciiciiciiect s msranssasnsmsnnsasmsssnnsasmnsannssannsannnnannrnnns 5
1.1 A CLOSER LOOK AT THE OSGI APPLICATION. ...cceitiiieuutuueneueneeeeeeeeeeeeaeaeaaasessssssaaassnsnsssssssssseeeeeeeaeaeeeeeeeessesnnnnnns 5
LI O N/ =N T TP EUPRPRN 6
PART 1: START THE WAS ENVIRONMENT ... it rees i m s s s ramsmnnsaamsssanssmnrammnsanmranmmnanmrnnns 7
PART 2: DEPLOY THE OSGI BANKINGAPPLICATION WEB APP ... v rvec v e e e e e e 11
PART 3: USE THE OSGI BANKINGAPPLICATION WEB APP......o i v v v e e e e e e 20
PART 4: DEPLOY AN UPDATE TO THE OSGI BANKINGAPPLICATION WEB APP.......ccceiieevevvveeee 24
PART 5: VALIDATE THE UPDATED OSGI BANKINGAPPLICATION WEB APP ... vevve e 30
[0 0 T o I ¥ K [0 33

Contents Page 3



IBM Software IBM Proof of Technology

Before you begin
This exercise guides you through the administration of a modular application using strategic
technologies: OSGi, the modular system for Java.

You will use the IBM® WebSphere® Application Server (WAS) version 8.0 cluster you
configured in Lab 1.

Upon completing this exercise you should have gained a basic understanding of the value and
basic concepts of OSGi,

You should possess basic knowledge of the IBM® WebSphere® Application Server (WAS)
version 8.0 administration console.

To follow this exercise, you will require:
« This document.
« The OSGi bundle files that accompany this exercise.

« IBM® WebSphere® Application Server Version 8.0 Environment (henceforth “WAS”) installed
and configured with a cluster defined as in Lab 1.
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About the application you will deploy

You will deploy a web application that manages bank accounts. The web application consists of
a single OSGi composition which consists of three OSGi bundles.

1. The BankingApplication OSGi application provides operations to open, close, deposit to,
withdraw from and access bank accounts. It also provides operations to work with bank
account owners. It includes a front-end JSP Web application for working with bank accounts
and their owners.

This diagram depicts the overall design of the OSGi web application:

p
BankingApplication
(OSGi Application)

-
_____ _| com.ibm.example.bankingweb | _ _ _ _ _ _________ __ com.ibm.example.banking.api
(Web bundle) ) | (Bundle)

|
Browser (HTML) com.ibm.example.banking.impl | _|
(Blueprint JPA bundle)

1.1 A closer look at the OSGi application

The “BankingApplication” OSGi application is a deployable unit containing three bundles that
work together to provide banking services including management of accounts and account
owners.

* The API bundle, com.ibm.example.banking.api, contains a Java interface and two data
classes that together define the public API of the banking application. There is no business
logic within the bundle.

* The implementation bundle, com.ibm.example.banking.impl, contains the main Java
implementation class that implements the Java interface in the APl bundle, and has the
business logic that does all the internal work of creating, storing, accessing, updating and
deleting bank accounts and bank account owners.

The bundle also defines the implementation class as an OSGi Blueprint bean, and
defines an OSGi Blueprint service based upon the bean and described by the
implementation's parent interface from the API bundle.

* The Web bundle, com.ibm.example.banking.web, contains a JSP Web application for
working with the bank accounts and account owners. The Web application consults the WAS
JNDI service to locate the Blueprint service registered by the implementation bundle so that
it can invoke operations without requiring a direct dependency on the implementation bundle
or the implementation class within it.
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1.2 Conventions
The bold typeface is used for text you need to enter or controls or objects such as push buttons
and tree nodes that you need to interact with.

The italic typeface is used for dialog titles, control labels and other information displayed by the
tools.

A few “variables” are used in this exercise to represent host names, port numbers and other
configurable aspects of WAS. The values shown here match the configuration of the VMware
images accompanying the exercise. If you are following this exercise on your own installation,
you may need to substitute different values.

Variable Value Explanation
<FILES> /Labfiles The directory containing files needed to
80 complete the exercise.
<HOST> Think The local host name.
<HTTP-PORT> 9080 The WAS HTTP port number. This is used in

the URLs of the 0SGi application's JSP Web
front end in the
com.ibm.example.banking.web bundle.
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Part 1: Start the WAS Environment

In this part of the exercise you will start the WAS Environment if it is not already started and
import and deploy the BankingApplication OSGi application. If the WAS Environment is already
started from Lab L0O1, skip to Part 2.

1. Start WAS.
a) Start the Deployment Manager
1. Select Applications > IBM Websphere 2> IBM WebSphere Application Server
Network Deployment - Profiles > Dmgr01 > Start the deployment manager
2. Wait for the start process to complete
b) Start the nodeagent
1. Start a terminal window by right clicking anywhere on the open desktop and select

Open Terminal.

1. Change directory to the AppSrv01 profile bin directory by entering the command
“cd /opt/IBM/WebSphere/AppServer/profiles/AppSrv01/bin”

2. Start the nodeagent by entering the command “./startNode.sh” Be sure to note
the “./” which prefaces the command. This signals to the OS command
processor that this command is in the local directory.

3. Wait for the messages that indicate that the nodeagent has successfully been
started. You should see output that looks like the following example. The
process id will vary

ADMUO01161: Tool information is being logged in file
/opt/IBM/WebSphere/AppServer/profiles/AppSrv01/logs/nodeagent/startServer.log

ADMUOQ0128I: Starting tool with the AppSrv01 profile

ADMU3100I: Reading configuration for server: nodeagent

ADMU3200I: Server launched. Waiting for initialization status.

ADMU3000I: Server nodeagent open for e-business; process id is 5615

c) Start the MyCluster cluster using one of the following methods. Option 1 is to use the
wsadmin command line administration tool. The other option is to use the web browser
based Admin Console GUI.

1. Invoke the wsadmin command from a terminal window(enter exactly as shown
including the quotes on a single command line)

lopt/IBM/WebSphere/AppServer/profiles/Dmgr01/bin/wsadmin.sh -lang

jython -C "AdminClusterManagement.startSingleCluster('MyCluster®)"

The system will display a prompt window requesting your credentials. Login with User
and Password values of “wasadmin” You will see the following output in the terminal
screen to indicate that the cluster was successfully started:

WASX7209I: Connected to process "dmgr" on node thinkCellManager01 using SOAP connector;
The type of process is: DeploymentManager

AdminClusterManagement: Start a cluster
Cluster name: MyCluster
Usage: AdminClusterManagement.startSingleCluster("MyCluster")

Administering OSGi Applications Page 7
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Return: If the command is successful, a value of 1 is returned.

Start cluster:
WebSphere:name=MyCluster,process=dmgr,platform=common,node=thinkCellManager01,version=8
.0.0.0,type=Cluster,mbeanldentifier=MyCluster,cell=thinkCell01,spec=1.0

OK: startSingleCluster('MyCluster', 'false'):

1

1. Close the terminal window by entering the command “exit”.

2. OR use the Admin Console
1. Open a Mozilla Firefox web browser window
2. Open a session with the Deployment Manager admin interface
1. Enter the URL http://localhost:9060/admin

[ TR http:/Mocalhost:9060/admin <

2. Login with UserlD and Password of “wasadmin”

WebSphere. BTG

WebSphere Integrated
Solutions Console

User D
|wasadmin ‘—f—
Password

Licensed Materials - Property of IBM (c) Copyright IBM Corp. 1997, 2011 All Rights Reserved. IBM, the I1BM
logo, ibm.com and WebSphere are trademarks or registered trademarks of International Business
Machines Corp., registered in many jurisdictions worldwide. Cther product and service names might be
trademarks of IBM or cther companies. A current list of 1BM trademarks is available on the web at
Copyright and trademark information

3. Expand Servers > Clusters
4. Select WebSphere application server clusters
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Welcome
[+ Guided Activities
[=) servers ‘.— 1
New server
(+] Server Types

(=) Clusters 4— 2

WebSphere application server clusters

Cluster topology

[+ DataPower

[#] Core Groups

5. Select the MyCluster entry and click on the Start button

ell=thinkCell01, Profile=Dmgro1

WebSphere application server clusters ? =

WebSphere application server clust

Use this page to change the configuration settings for a cluster. A server cluster consists of a group of
application servers. If one of the member servers fails, requests will be routed to other members of the cluster.

Learn more about this task in a guided activity. A guided activity provides a list of task steps and more general
information about the topic.

v@ Preferences
New... | Delete I Start ] Stop | Ripplestart ] ImmediateStop ]

el

N

Select | Name & Status @

You can administer the following resources:

MyCluster @

Total 1 1

After a short time, the Status will turn into a green arrow to indicate that it
successfully started.

6. Continue to the next section.
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Cell=thinkCeli01, Profile=Dmgro1

WebSphere application server clusters ? -

WebSphere application server clusters

Use this page to change the configuration settings for a cluster. A server cluster consists of a group of
application servers. If one of the member servers fails, requests will be routed to other members of the cluster.
Learn more about this task in a quided activity. A guided activity provides a list of task steps and more general
information about the topic.

# Preferences

| New.. || Delete || start | Stop | Ripplestart || ImmediateStop |

&5

Select ‘ Name ¢ ‘ Status Q

You can administer the following resources:

O IM \0

Total 1
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Part 2: Deploy the OSGi BankingApplication Web app

In this part of the exercise, you will take several java archive files which are packaged as OSGi
bundles. You will import them into the WAS internal bundle repository from where they can be
made accessible to an OSGi application. The repository may contain multiple versions of a
bundle and each OSGi application can utilize the desired version based. This mechanism allows
for multiple versions of the same java class to be loaded in the WAS jvm and be used at the

appropriate version by the requesting application.

1. Import the BankingApplication OSGi bundles.
a) Log on to the WAS Admin Console.
b) Expand Environment
c) Expand OSGi bundle repositories
d) Select Internal bundle repository

+ Security

=] Environment 4— 1

Virtual hosts

SIP application routers
Replication domains
+ Naming
(=) OSGi bundle repositoriesé‘_ 2

Bundle cache

External bundl sitories

Internal bundle reposito

+ System administration

e) Click on the New... button

ntern

Internal bundle repository

The internal bundle repository can store bundles that are referenced by OSGi applicat
WebSphere Application Server. When an OSGi application is imported as an asset, th
attempts to satisfy all its dependencies by using the contents of the asset, the conte

bundle repository, and the contents of any available external bundle repositories.
4 Preferences
New... Delete
haadli
~

Select Bundle Symbolic Name £ Bundle Version {&
None

Total 0

f) Select Local file system then click on the Browse... button

Administering OSGi Applications
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Internal bundle repository > New...

Upload a bundle into the internal bundle repository.

Path to bundle

9 Local file system

Specify path

BmwsL<_

Remote file system

Browse
OK Cancel

g) Navigate to the /Labfiles80/OSGiApplication folder and select the
com.ibm.example.banking.api_1.0.0.jar file and click Open then OK on the next

screen. .

Internal bundle repository > New...
Upload a bundle into the internal bundle repository.

Path to bundle

@ Local file system
Specify path

Ipie.banlqng.apd_L0.0.;ar Browse_.
©) Remote file system [ Specifies whether to browse the local machine
Browse
OK Cancel I

h) Repeat steps (f) and (g) for the following two additional jar files
1. com.ibm.example.banking.impl_1.0.0.jar
2. com.ibm.example.banking.web_1.0.0.jar
2. Import the BankingApplication enterprise bundle application (EBA)
a) Within the Navigation frame on the left side, expand Applications
b) Expand Application Types
c) Select Assets

[+ Servers

(=] Applications 4—

enterprise applications
evel applications

Global deployment settings

d) Click on the Import button
e) Click on the Browse... button
f) Navigate to the /Labfiles80/OSGiApplication folder and select the
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BankingApplication_1.0.0.eba file.

Select the asset package to import.

Path to the asset

@ Local file system
Specify path

lngApp/BankingAppIication_l.OAerbd Browse...

O Remote file system

Next | Cancel |

g) Click Open then on the following screen click the Next button.
h) Click on Next through Steps 1 and 2. Ignore any warnings that might appear.
i) On Step 3: Summary, Click on the Finish button.

Import an asset to the asset repository -

Use this wizard to import assets to the asset repository.

Step 1: Select Summary

options for importing

an asset The following is a summary of your selections. Click Finish to
complete the application creation. If there are settings that you
Step 2: EBA asset want to change, click Previous to review the settings.
conversion and

resolution warnings

Summary:
> Step3: Summary Asset name :
BankingApplication_1.0.0.eba

Asset binaries destination URL : -
${USER_INSTALL_ROOT }/installedEBAs
/BankingApplication_1.0.0

Asset type aspects :
WebSphere:spec=EBA,version=1.0

(«]

Previous | Finish | Cancel |

You should soon see the result that the asset has been successfully added. Save your
changes to the master repository.

10/7/11 1:59:32 AM EDT Completed res=[WebSphere:assetname=BankingApplication_1.0.0.eba]

Operation completed successfully.

3. Create the BankingApplication business level application (BLA)
a) Under Applications - Application Types, select Business-level applications
b) Click on the New... button
c) Type “Banking Application” in the Name field. Also type a suitable description such as
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“OSGi banking application” into the Description field and click on the Apply button

Business-level applications 7=
Business-level applications > New...

Use this page to manage the composition units in the business-level application.

General Properties

Name

Banking Application

Description

QSGi banking application

Apply I Reset | Cancel I

d) Click on the Add button in the “Deployed Assets” section
e) Click on the Add Asset selection

=) Messages

[ Banking Application was successfully created.

&Changes have been made to your local configuration. You can:
® Save directly to the master configuration.

® Review changes before saving or discarding.

& The server may need to be restarted for these changes to take
effect.

Business-level applications > Banki

g Application

Use this page to manage the composition units in the business-level application.

General Properties

Name

|Ean}<mg Application

Description

QSGi banking application

4 : I%ete
[ Add Asset

Add Shared Librad

Select| yame

Description Type Status Q

None

Business-level applications

Add Delete

f) Select the BankingApplication_1.0.0.eba asset and click on the Continue button

Page 14
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Business-level applications

[=] Messages

® Review changes before saving or discarding.

&Changes have been made to your local configuration. You can:
® Save directly to the master configuration.

& The server may need to be restarted for these changes to take effect.

Business-level applications > Banking Application > Add

Add assets to the business-level application to create a composition unit.

TE

o ‘@\
20 |

Select| Name

Description {

;ég BankingApplication_1.0.0.eba

BankingApplication

Total 1
Continue Cancel

g) Accept the defaults for Step 1 by clicking on the Next button.

h) For Step 2: Map composition unit to a target, be sure to select both the MyCluster

cluster and the webserver1 and click on the arrow pointing to the right. This will deploy
the application to both the cluster and instruct WAS to configure the webserver plugin

correctly. Click on the Next button to continue.

Set options settings

Use this page to specify options for the composition unit to be added to the business-level application.

rget

Step 1: Setoptions Map composition unit to a ta
Step 2: Map
o Current targets
composition unitto a
target ‘
Available:

Step 3: Map context
roots

WebSphere:cluster=

Step 4: Map modules

MyCluster

to virtual hosts

Step 5: Summary

Previous | Next'| Cancel |

d Selected:

Kl

i) Enter “/BankingApplication” into the Context Root field and click on the Next button.

Administering OSGi Applications
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Set options settings

Use this page to specify options for the composition unit to be added to the business-level application.

Step 1: Set options

Step 2: Map
composition unit to
a target

Step 3: Map context
roots

Step 4: Map
modules to virtual
hosts

Step 5: Summary

Previous Next

Map context roots

Bundle Symbolic Name

Bundle Version

Context Root

com.ibm.example.banking.web

1.0.0.201109270848

/BankingApplication e

Cancel

)

IBM Proof of Technology

On Step 4: Map modules to virtual hosts, click on the Next and then the Finish button to

complete the definition.
k) Be sure to review and save the changes to the configuration and synchronize the

changes to

the cell.

Adding composition unit to the business-level application

Adding composition unit to the business-level application

The current state of composition unit addition.

Operation completed successfully.

10/3/11 10:40:52 AM EDT Completed res=[WebSphere:cuname=BankingApplication_1.0.0_0001.eba]

Changes hgfve been made to your local configuration. You can:
Save gfrectly to the master configuration.

Revi®w changes before saving or discarding.

To work with the application, click the "Manage application” link.
Manage application

Adding composition unit to the business-level application

Adding composition unit to the business-level application > Save

Save your workspace changes to the master configuration.

Click Save to update the master repository with your changes. Click Discard to discard your changes and
begin work again using the master repository configuration. Click Cancel to continue working with your

changes.

@ Total changed documents: 15

Syncjfronize changes with Nodes

| sav®| Discard ||

Cancel

Page 16
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[) Since the default is to not start the application upon distribution, you will need to

manually start the application. Select the Banking Application which you just created
and click on the Start button.

Business-level applications ?

Business-level applications

Use this page to manage business-level applications. A business-level application is a configuration that
represents any artifacts that the application needs to run. Artifacts typically include Java(TM) Platform,
Enterprise Edition (Java EE) applications or modules, shared libraries, data files, or other business-level
applications.

# Preferences

Start Stop] New.. || Delete
L [

Select Name $ Description < Status "_3

etiminister the following resources:

Banking Application OSGi Banking application @

4. Configure the webserver so it can route requests to the newly deployed application. Expand
the Servers then Server Types in the navigation panel. Then click on the Web servers link

(=) sarvers ‘—_ 1
New server

(=) Sarver Types ‘-— 2

5. Select webserver1 and click on the Generate Plug-in button.

Web servers ? -

Web servers
Use this page to view a list of the installed web servers.
# preferences
Generate Plug-in | Propagate Plug-in l New... ] Delete I Templates... ] Start ] Stop l |

El=lElE

Select| Name & Web server Type C_ Node C_ Host Name C_ Version C_ Status ®

You can administer the following resources:

webserver1 IBM HTTP Server thinkNode01 think.ibm.com ND 8.0.0.0 | ¥

Total 1 1

6. Reselect webserver1 and click on the Propagate Plug-in button

Administering OSGi Applications Page 17
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Web servers

TE

Web servers

Use this page to view a list of the installed web servers.

Preferences 2

| Generate Plug-in || Propagate Plug-in | New.. | Delete | Templates.. | Start | Stop || |
w5316

s A A~ ~ ~ . ~ c‘,
elect Name v Web server Type v _ Node v _ HostName v _ Version v _ | Status ¢

You can administer the following resources:

webserver1 ‘ IBM HTTP Server ’ thinkNode01 ’ think.ibm.com ’ ND 8.0.0.0 ‘ ®
Total 1 1

7. Lastly, start the Web server by reselecting webserver1 and click on the Start button.

Web servers

Web servers
Use this page to view a list of the installed web servers.

2

Preferences

| Generate Plug-in || Propagate Plug-in | New.. | Delete | Templates...\IFStart || stop | |
w5316

Select’ Name < ’ Web server Type C_ ’ Node C_ ’ Host Name C_ ’ Version C_ ‘ Status ®

You can administer the following resources:

webserver1 ‘ IBM HTTP Server ’ thinkNode01 ’ think.ibm.com ’ ND 8.0.0.0 ‘ ®
Total 1 1

8. Ensure that the Status for webserver1 turns green to indicate that it has successfully
started. You may also notice a message in the top of the panel.

Web servers ? -
=l Messages
[i} server thinkNode01/webserver1 started successfully. The collection may need to
be refreshed to show the current server status.
Web servers \
Use this page to view a list of the installed web servers.
Preferences
l I || New.. || ||_Templates... || “tart || “top || |
El=IEIE
A ~ ~ ~ . ~ c‘)
Select| Name v Web server Type v _ Node v _ Host Name v _ Version v | Status ¢
You can administer the following resources:
[0 | webservert ‘ IBM HTTP Server ‘ thinkNode01 ‘ think.ibm.com ’ ND 8.0.0.0 | &
Total 1
Page 18
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In this part of the exercise you started the WAS Environment, imported, deployed, and started
the Java EE “BankingApplication” OSGi application. You also generated an updated webserver
plugin configuration to support the new application.

Administering OSGi Applications Page 19
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Part 3: Use the OSGi BankingApplication Web app

In this part of the exercise you will use the Web front-end of the OSGi application to create an
account owner, open a bank account and deposit some funds. You will also monitor the WAS
SystemOut.log files for both servers in the cluster to validate that the application is working as
desired.
1. Monitor the SystemOut.log file
a) Start a terminal window by right clicking anywhere on the open desktop and select
Open Terminal.

Create Folder
Create Launcher...
Create Document

Open Terminal

i Clean Up by Name
3 Keep Aligned

Change Desktop Background

b) Resize the window by dragging a corner so that it covers most of the width of the
screen, but only about V4 of the height of the screen.

root@think:~

File Edit View Terminal Tabs Help
[root@think ~1# ||

c) Enter the command “tailf
lopt/IBM/WebSphere/AppServer/profiles/AppSrv01/logs/server2/SystemOut.log’
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root@think:~

File Edit View Terminal Tabs Help
[root@think ~]# tailf /opt/IBM/WebSphere/AppServer/profiles/AppSrv01l/logs/server2/SystemOut.log l

d) Start another terminal window by right clicking anywhere on the open desktop and
select Open Terminal.

e) Resize the window by dragging a corner so that it covers most of the width of the
screen, but only about V4 of the height of the screen.

f) Enter the command “tailf
lopt/IBM/WebSphere/AppServer/profiles/AppSrv01/logs/server3/SystemOut.log’

g) Enter the command “tailf
lopt/IBM/WebSphere/AppServer/profiles/AppSrv01/logs/server2/SystemOut.log’

1 hin ¥

[ root@think:~ =)
File Edit View Terminal Tabs Help
[root@think ~]# tailf /opt/IBM/WebSphere/AppServer/profiles/AppSrv0l/logs/server3/SystemOut.log l_

2. Launch the Web application in the Mozilla Firefox browser (or open another tab in your
current browser)

a) Select Applications > Internet > FireFox web browser

M IR Places  System |
@ Accessories 1 4
@ Graphics ’

[ 1BM HTTP Server v8.0 ’

@ IBM Installation Manager

@ IBM Software Delivery Platform

IBM WebSphere

';\ Internet

.‘ Firefox Web Browser

ﬁ Programming 4 :j) KNewsTicker

—d —
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b) Open http://localhost/BankingApplication/index.jsp

c) You should see the International Bank of Bundles Web application page like below.
International Bank of Bundles

Access Accounls

Balance: Account numberl Get balance

Deposit: Account numberl $ I Deposit
Withdraw: Account numberl $ I ‘Withdraw
Administer Clients

Client ID [First Name [Last Name |

Add new client: First name | Last name Add new client

Administer Accounis

]Accouni Number|Bannce ]0wner‘

Add new account: Client ID | Add new account
Refresh

Purge all clients and accounts! |

3. Create an account owner.

a) Inthe Administer Clients section of the Web application, enter the following names into
the First name and Last name fields, then press Add new client.

1. First name = John
2. Last name = Doe

b) The status message “Owner 100 added successfully” should appear in the grey status
area.

c) Inspect all of the SystemOut.log tails. In one of the windows, you should see several
lines of output produced by System.out.printin(...) calls that are instrumented throughout
the Java implementation classes of the application. For instance, after step [a] above,
the last few lines of the console should read as follows:

com.ibm.ws.webcontainer.servlet.ServletWrapper init SRVE0242T:...
[0SGi] AccountManagerImpl.getOwners () = []

[0SGi] AccountManagerImpl.getAccounts() = []

[JSP] index.jsp: owners = []

[JSP] index.jsp: accounts = []
com.ibm.ws.webcontainer.servlet.ServletWrapper init SRVE0242T:...
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Servlet] AddAOwnerServlet (...

Servlet] AddAccountServlet(...) firstName=John
0SGi] AccountManagerImpl.createOwner (Doe,John) = 100

[
[
[Servlet] AddAccountServlet(...) lastName=Doe
[
[

0SGi] AccountManagerImpl.getOwners () =
[Owner{id=100, firstName=John, lastName=Doe} ]
[0SGi] AccountManagerImpl.getAccounts() = []
[JSP] index.jsp: owners =
[Owner{id=100, firstName=John, lastName=Doe} ]
[JSP] index.jsp: accounts = []

4. Create an account.

a) Inthe Administer Accounts section of the Web application, enter the client number 100

into the Client ID field, then press Add new account.

b) The status message “Account 1000 opened successfully* should appear in the grey

status area.
c) Again, inspect the SystemOut.log displays.
5. Deposit funds into the account.

a) Inthe Access Accounts section of the Web application, enter account number 1000 into
the Deposit: Account number field, enter 10000 into the $ field, then press Deposit.

b) The status message “Funds in the amount $10,000.00 deposited to account 1000. The

new balance s $10,000.00.” should appear in the grey status area.

c) Again, inspect the SystemOut.log displays.

6. Keep the terminal windows open and maintain the tailf commands.

In this part of the exercise you used the OSGi Web application to create a new account owner
(or client) and a new bank account. You deposited funds into the bank account which will be
important if you are going to buy any stock in the next part of the exercise. You also monitored

the SystemOut.log files to determine which server instance handled the request.

Administering OSGi Applications
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Part 4: Deploy an update to the OSGi BankingApplication
Web app

In this part of the exercise, you will be provided an update OSGi bundle file which is provided as
a java archive file. During the initial testing of the application, it was discovered that the starting
value for clientIDs and account numbers was wrong. Instead of 100, the starting value for client
IDs is supposed to be 200. The starting account number is also supposed to be 2000 instead of
1000. As a result, the development team has generated an updated implementation bundle and
you need to import and activate this update for the next round of testing. You will import this
bundle into the WAS internal repository from where it can be made be used to update the
deployed OSGi BankingApplication. As you will see, the repository may contain multiple
versions of a bundle. As long as the OSGi Composition permits, the System Administrator will
determine which version will be the desired version based. This allows a System Administrator
to be able to load and test updates (or roll back changes) quickly and efficiently.

1. Import the updated BankingApplication OSGi bundle.
a) Log on to the WAS Admin Console.
b) Expand Environment
c) Expand OSGi bundle repositories
d) Select Internal bundle repository

+ Security

=] Environment ‘_ 1
Virtual hosts

+/ Naming

i[-] OSGi bundle repositories’_ 2

Bundl che

External bundle repositories
Internal bundle FE[;\:EHI:ZF‘;‘— 3

+ System administration

e) Click on the New... button

Internal bundle repository

The internal bundle repository can store bundles that are referenced by OSGi applicat
WebSphere Application Server. When an OSGi application is imported as an asset, th
attempts to satisfy all its dependencies by using the contents of the asset, the conte
bundle repository, and the contents of any available external bundle repositories.

4 Preferences
New... Delete

f) Click on the Browse... button
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Internal bundle repository > New...

Upload a bundle into the internal bundle repository.

Path to bundle

@ Local file system

Specify path

| [ Browse. | —

7 Remote file system

Brovse
OK Cancel I

g) Navigate to the /Labfiles80/0OSGiApplication/Updates folder and select the
com.ibm.example.banking.impl_1.0.1.jar file.

Internal bundle repository vE

Internal bundle repository > New...

Upload a bundle into the internal bundle repository.

Path to bundle

@ Local file systV
Specify path

lple.banking.api_1.0.0.jar Browse
©) Remote file system [ Specifies whether to browse the local machine
Browse
OK Cancel

h) Save and synchronize changes.

2. Update the BankingApplication enterprise bundle application (EBA)
a) Within the Navigation frame on the left side, expand Applications
b) Expand Application Types
c) Select Assets

[+ Servers

[ Applications  fmm—

Application

erprise applications

Business-le applications

Assets 4—

Global deployment settings

d) Click on the BankingApplication_1.0.0.eba asset.

Administering OSGi Applications
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Assets

Use this page to manage assets in the asset repository. Assets represent physical binaries. Examples of assets
include compressed (zip) files, Enterprise JavaBean (EJB) Java(TM) archive (JAR) files, EAR files, Service
Component Architecture (SCA) composite JAR files, mediation JAR files, shared library JAR files, and non-Java
EE contents such as PHP applications.

* Preferences

Import | Delete | Update | Export

A A
Select Name v Description v
You can administer the following resources:

O BankingApplication_1.0.0.eba ‘— BankingApplication

Total 1

e) On the far right hand section of the primary panel, under Additional Properties, select
Update bundle versions in this application

[

Interprise JavaBean (EJB) Java(TM) archive (JAR)
ents such as PHP applications.

Additional Properties

Export the
deployment
manifest from
this application
Import a

deployment
manifest into

this application

Update bundle
> yr©1'5i0NS i this

application

f)  Click on the pulldown for the com.ibm.example.banking.impl bundle and select the
1.0.1.201109270848 (you might have 1.0.1.201109282146 instead) version. Then click
on the Preview button
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Assets

Assets > BankingApplication 1.0.0.eba > Update bundie versi in this

Update the versions of the bundles that comprise this application.

Application bundle content

Content

Symbolic Name = Sharing | Deployed Version New Version
ype

com.ibm.example.banking.api | Bundle | Isolated | 1.0.0.201109270848 |N0 preference jl
com.ibm.example.banking.impl | Bundle | Isolated | 1.0.0.201109270744 o l:No preference iv|
No preference
com.ibm.example.banking.web | Bundle | Isolated | 1.0.0.2 270848 1.0.0.201109270744
1

/' 1.0.1.201109270848 )
1.0.1.201109282146
Preview_| Cancel s 2

g) Notice the informational message. Although the application definition has been updated,
it will not take effect until the BLA is updated to use the new deployment. This will occur
the next time the application is restarted, or when an Administrative action to perform

the update has been performed. Click on the Create button to generate the updated
deployment.

Assets

Assets > BankingApplication 1.0.0.eba > Update bundle versions in this application > Preview

A preview of the result of the proposed changes to the bundle versions in this application.

The selected bundle versions can be resolved, so you can now create a new deployment
[} with the proposed bundle versions. The new deployment will not affect any composition
units for this asset until the composition units are updated to use the new deployment.

Application bundle content

Symbolic Name Deployed Version New Version

com.ibm.example.banking.api 1.0.0.201109270848 1.0.0.201109270848
com.ibm.example.banking.impl 1.0.0.201109270744 1.0.1.201109270848
com.ibm.example.banking.web 1.0.0.201109270848 1.0.0.201109270848

Create Cancel

h) Click on the OK button to complete processing of the BankingApplication asset.

EBA Dependencies

Bundle downloads are complete.

OK || Cancel

i) Save and synchronize changes.

3. Update the BankingApplication business level application (BLA)
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a) Under Applications - Application Types, select Business-level applications (BLA)
b) Click on the Banking Application.

Start I Stop | New... | Delete I

85
Select| Name e Description e Status Q

You can administer the following resources:
[l Banking Application &4 |osai Banking application P

c) Click on the BankingApplication_1.0.0_0001.eba asset link

General Properties

Name
Banking Application

Description
0SGi Banking application

Deployed assets

Add ~ | Delete
Select| Name Description Type Status Q
O BankingApplication_1.0.0, 0001.eba4—_ asset P

d) Click on the Update to latest deployment ... button

OSGi application deployment status
New OSGi application deployment available.

Update to latest deployment ... ] <

Applyl OK ] Reset | Cancel |

Review the differences between the currently Deployed Version and the New Version to
be sure that they are correct. Then click on the OK button

Lab 2
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Business-level applications > Banking Application > BankingApplication 1.0.0 0001.eba >
Preview

A preview of the result of the proposed changes to the bundle versions in this application.

Symbolic Name Deployed Version New Version

com.ibm.example.banking.api | 1.0.0.201109270848 1.0.0.201109270848

com.ibm.example.banking.imp|/ 1.0.0.201109270744 | 1.0.1.201109270848

com.ibm.example.banking.web | 1.0.0.201109270848 | 1.0.0.201109270848

OK Cancel

f) Click on the OK button.

OSGi application deployment status

Using latest OSGi application deployment.

[ |

Apply || OK | Reset || cancel |

g) Be sure to review and save the changes to the configuration and synchronize the
changes to the cell.

Business-level applications

= Messages
& Changes have been made to your local configuration. You can:
e Save directly to the master configuration.

e Review changes before saving or discarding.

An option to synchronize the configuration across multiple nodes after
saving can be enabled in Preferences.
& The server may need to be restarted for these changes to take effect.

Business-level applications

Business-level applications > Banking Application > Save
Save your workspace changes to the master configuration.

Click Save to update the master repository with your changes. Click Discard to discard your changes and
begin work again using the master repository configuration. Click Cancel to continue working with your

changes.

Total changed documents: 10

A/

Syncpfonize changes with Nodes

| save || Discard || cancel
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Part 5: Validate the updated OSGi BankingApplication
Web app

As before you will use the Web front-end of the OSGi application to create an account owner,
open a bank account and deposit some funds.

7. Launch the Web application in the Mozilla Firefox browser.
a) Select Applications > Internet > FireFox web browser

MV CTTTETTEN Places  System |
@ Accessories 1 »
@ Graphics 4

IBM HTTP Server V8.0 »

9 IBM Installation Manager

\J) IBM Software Delivery Platform

IBM WebSphere

i\ Internet

., Firefox Web Browser

v

ﬁ Programming :‘U KNewsTicker

—d —

b) Open http://localhost/BankingApplication/index.jsp

c) You should see the International Bank of Bundles Web application page like below.
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International Bank of Bundles

Access Accounis

Balance: Account numberl Getbalance

Depaosit: Account numberl $ I Depaosit
Withdraw: Account numberl $ I ‘ithdraw
Administer Clients

Client ID [First Name [Last Name ]

Add new client: First name | Last name Add new client

Administer Accounis

]Accouni Number\BaIance |0wner|

Add new account: Client ID | Add new account
Refresh

Purge all clients and accounts! |

8. Create an account owner.

a) Inthe Administer Clients section of the Web application, enter the following names into
the First name and Last name fields, then press Add new client.

1. First name = Jane
2. Last name = Doe

b) The status message “Owner 200 added successfully” should appear in the grey status
area. This verifies that the updated implementation bundle is being used.

c) Inspect both of the SystemOut.log tails. In one of the windows, you should see several
lines of output produced by System.out.printin(...) calls that are instrumented throughout
the Java implementation classes of the application. For instance, after step [a] above,
the last few lines of the console should read as follows:

com.ibm.ws.webcontainer.servlet.ServletWrapper init SRVE0242T:...
[0SGi] AccountManagerImpl.getOwners () = []

[0SGi] AccountManagerImpl.getAccounts() = []

[JSP] index.jsp: owners = []

[JSP] index.jsp: accounts = []
com.ibm.ws.webcontainer.servlet.ServletWrapper init SRVE0242T:...
[Servlet] AddAOwnerServlet (...

[Servlet] AddAccountServlet(...) firstName=Jane
[Servlet] AddAccountServlet(...) lastName=Doe
[0SGi] AccountManagerImpl.createOwner (Doe, Jane) = 200
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[0SGi] AccountManagerImpl.getOwners () =
[Owner{id=200, firstName=Jane, lastName=Doe} ]
[0SGi] AccountManagerImpl.getAccounts() = []
[JSP] index.jsp: owners =
[Owner{id=200, firstName=Jane, lastName=Doe} ]
[JSP] index.jsp: accounts = []

9. Create an account.

a) Inthe Administer Accounts section of the Web application, enter the client number 200
in the Client ID field, then press Add new account.

b) The status message “Account 2000 opened successfully* should appear in the grey
status area. This verifies that the updated implementation bundle is being used.

c) Again, inspect the two SystemOut.log displays.
10. Deposit funds into the account.

a) Inthe Access Accounts section of the Web application, enter account number 2000 into
the Deposit: Account number field, enter 10000 into the $ field, then press Deposit.

b) The status message “Funds in the amount $10,000.00 deposited to account 2000. The
new balance s $10,000.00.” should appear in the grey status area.

c) Again, inspect the two SystemOut.log displays.

11. Press Ctrl+C in each of the command windows where you have been monitoring the
SystemOut.log files. This will terminate the tailf command.

12. Enter the “exit” command in each of the command windows. This will close out the terminal
windows.

In this part of the exercise you used the updated OSGi Web application to create a new account
owner (or client) and a new bank account. You verified that the updated module was used to
create client IDs and account numbers using the new ranges.

Congratulations!

You have reached the end of the exercise!
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Conclusions

In this exercise, you the WebSphere Application Server Runtime Environment to import, deploy,
run and test a java application packaged using the OSGi models.

You explored the various WAS Admin GUI capabilities for OSGi bundle and application
management, including how to import bundles to the local repository and update a running
OSGi application.

Optionally, you were able to explore wsadmin scripting equivalents to the administrative tasks
you performed through the interactive console.
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Lab 3 WebSphere Application Server V8 High Performance
Extensible Logging

High Performance Extensible Logging (HPEL) is a new log and trace facility. It provides a convenient
mechanism for storing and accessing log, trace, System.err, and System.out information produced by the
application server or applications. It is an alternative to the basic log and trace facility, which provides the
JVM logs, diagnostic trace, and service log files commonly named SystemOut.log/SystemErr.log,
trace.log, and activity.log. HPEL provides a log data repository, a trace data repository, and a text log file.

For more information about HPEL, see the following WebSphere Application Server V8.0 information
center topic: Using HPEL to troubleshoot applications

This lab is provided AS-IS, with no formal IBM support.

1.1 Lab requirements

Lab 1 WebSphere Application Server V8 Network Deployment Installation and Configuration completed.

1.2 What you should be able to do

At the end of this lab you should be able to

* Enable and configure HPEL.
* Use the HPEL command line log viewer.
e Use the HPEL log viewer included in the WebSphere administrative console.

1.3 Introduction
This lab is intended as a short primer new High Performance Extensible Logging capability in WAS V8.

The aim of the lab is to walk though the steps that a systems administrator would perform to enable and
use HPEL from a command and the WAS V8 administrative console.

1.4 Exercise instructions

Some instructions in this lab may be Linux ® operating-system specific. If you plan on running the lab on
an operating-system other than Linux®, you will need to execute the appropriate commands, and use
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appropriate files ( .sh vs. .bat) for your operating system. The directory locations are specified in the lab

instructions using symbolic references, as follows:

Reference variable Windows® location

<WAS_HOME> C:\IBM\WebSphere\AppServer

<PROFILE_HOME> C:\IBM\WebSphere\AppServer\profiles\AppSrv01

<LAB_FILES> C:\Labfiles80

<TEMP> C:\temp

Linux®or UNIX® locations

lusr/WebSphere/AppServer

lopt/WebSphere/AppServer
lusr/WebSphere/AppServer/profiles/AppSr

vO1

lopt/WebSphere/AppServer/profiles/AppSr
v01

/Labfiles80

/tmp

Note for Windows users: When directory locations are passed as parameters to a Java program such as
EJBdeploy or wsadmin, it is necessary to replace the backslashes with forward slashes to follow the Java
convention. For example, C:\Labfiles80\ would be replaced by C:/Labfiles80/

1.5 Enable and Configure HPEL.

1. Log into the Admin console and inside the console navigate to Troubleshooting -> Logs and Trace —

server2

Lab 3
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View:|AIIlasks 3 l thinkCello1, Profile=Dmgro1

Welcome - -
Logging and tracing
[+ Guided Activities

%) Servers Logging and tracing
B EE Use this page to specify how the server handles log records. You can select an application server to enable or
(] Jobs disable a system log for that server, specify where log data is stored, and choose a format for log content. You
[#] Services can also specify a log detail level for components and groups of components.

& |Resources * preferences

[+] Security v o
- e

[+ Environment

[+] System administration Server v Node © Host Name ~ Version ~ Type < Status ©

) W GIE] ST You can administer the following resources:

[#] Monitoring and Tuning

dmgr thinkCellManager01 | think.ibm.com ND 8.0.0.0 servers P
(=] Troubleshooting
logand Tace nodeagent thinkNode01 think.ibm.com ND 8.0.0.0 servers 4
Configurationlproblems | server2 thinkNode01 think.ibm.com | ND 8.0.0.0 servers P
Class loader viewer I -
Java dumps and cores server3 thinkNode01 think.ibm.com ND 8.0.0.0 servers o

[# Configuration Validation
[+] Diagnostic Provider Total 4

[#] Runtime Messages

[#] Service integration

[+/ UDDI

2. Click the Switch to HPEL Mode button and Save this configuration change. Note enabling HPEL is
made to one server at a time. You will need to restart the server for HPEL to take affect. We will restart
the server in a later step.

Logging and tracing 2=

Logging and tracing > server2

It is recommended that you switch to High Performance Extensible Logging (HPEL) if you have no
existing procedures that prevent you from taking advantage of it.
(Advised

Switch to HPEL Mode | for most
installations)

Use this page to select a system log to configure, or to specify a log detail level for
components and groups of components. Use log levels to control which events are
processed by Java logging.

3. Click the OK button. You will return to the Logging and tracing screen. Chose server 2 to review and
configure the HPEL settings.
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4. Select Configure HPEL Logging.

Logging and tracing 2=

Logging and tracing > server2

Use this page to select a system log to configure, or to specify log detail levels for components and groups
of components.

General Properties

Configure HPEL logging

Current status not available
Configure HPEL trace

Current status not available
Configure HPEL text log

Current status not available

___a. On the HPEL Log Configuration page we can customize a variety of logging properties. Review the
different logging configuration options on this page. Note the drop down options under Begin
cleanup of oldest records checkbox option and the Out of space action drop down. Change the
Maximum log size to 20 and the click the OK button. Do not Save yet.

Logging and tracing > server2 > HPEL Log Configuration

Use this page to configure High Performance Extensible Logging (HPEL) log options. The HPEL log can be viewed
using the logViewer command (in the profile bin directory), or using the View HPEL Logs and Trace link.

Configuration

General Properties Additional Properties

# Directory path Change log detail levels
[${SERVER_LOG_ROOT}

Enable log record buffering
Start new log file daily at: | 12 AM ~| Related ltems

Log record purging policies View HPEL logs and

Begin cleanup of oldest records trace
| when log size approaches maximum :]l

48

Maximum log size
20 Megabytes

# Out of space action
| Stop logging :]|

Apply | OK | Reset | Cancel |
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5. Next chose the Configure HPEL trace from the Logging and tracing > server 2 page.
Logging and tracing

Logging and tracing > server2

Use this page to select a system log to configure, or to specify log detail levels for components and groups

of components.

General Properties

Configure HPEL logging

Current status not available
Configure HPEL trace

Current status not available
Configure HPEL text log

Current status not available

___a. Onthe HPEL Trace Configuration page we can customize a variety of trace properties. Review the
different logging configuration options. Note that we see the same options as on the HPEL Log
configuration page with one new option, Trace to a memory buffer. Also note that the directory for
the HPEL traces is also used to dump the memory buffer if Trace to a memory buffer is selected.
Under the check box Begin cleanup of oldest records, chose when oldest records reach age limit
from the drop down box and the change the Log record age limit to 12. Click the OK button. Do not
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Save yet.

Logging and tracing ‘

Logging and tracing > server2 > HPEL Trace Configuration

Use this page to configure High Performance Extensible Logging (HPEL) trace options. The HPEL trace can be
viewed using the logViewer command (in the profile bin directory), or using the View HPEL Logs and Trace link.

Configuration

General Properties Additional Properties

@ Trace to a directory Change log detail
Enable log record buffering levels

Start new log file daily at: | 12 AM ~|

Log record purging policies

Related ltems

Regii cieanup of oldest records

{- when oldest records reach age limit _-_'j! View HPEL logs and
trace
l.og record age limit
112] ~ Hours old
50

# QOut of space action
Purge old records j|

O Trace to a memory buffer
*

8

# Directory to use for tracing and dumping memory
buffer
|${SERVER_LOG_ROOT}

Apply | OK | Reset | Cancel |
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6. . Next chose the Configure HPEL text log from the Logging and tracing > server 2 page.

Logging and tracing > server2

Use this page to select a system log to configure, or to specify log detail levels for components and groups
of components.

General Properties

Configure HPEL logging

Current status not available
Configure HPEL trace

Current status not available
Configure HPEL text log

Current status not available

___a. Onthe HPEL Text Log Configuration page we can customize a variety of text logging properties.
The HPEL text log option allows you to output a traditional text log file along with the binary HPEL
files. For production use, you would want turn off the text logging capability by unchecking the
Enable text log check box. Review the different logging configuration options. Note we see many of
the same options that are found on the HPEL Log configuration page with two additional options for
choosing the Text output format and the option to Include trace records. Turn off text logging by
unchecking the Enable text log check box. Click the OK button and Save these configuration
changes. Click the OK button on the Synchronize Changes with Nodes screen.

7. Go to terminal window and navigate to the
lopt/IBM/WebSphere/AppServer/profiles/AppSrv01/logs/server2 directory. Type Is —al at prompt.
Note the directory and file structure.

|'-"»" root@think:/opt/IBM/WebSphere/AppServer/profiles/AppSrvOl/logs/server2
File Edit View Terminal Tabs Help

[root@think server2]# 1s -al
total 68

drwxr-¥r-x 2 root root 4096 Sep 29 15:56 .

drwxr-xr-x 7 root root 4096 Sep 29 15:55 ..

| -rw-r--r-- 1 root root 168 Sep 29 15:56 native stderr.log
-rw-r--r-- 1 root root 2044 Sep 29 15:56 native stdout.log
-rw-r--r-- 1 root root 4 Sep 29 15:56 server2.pid
-rw-r--r-- 1 root root 168 Sep 29 15:56 SystemErr.log
-rw-r--r-- 1 root root 41138 Sep 29 23:37 SystemOut.log

[rool@think server2]#

8. Stop server2. Delete all the files in the /opt/IBM/WebSphere/AppServer/profiles/AppSrv01/server2
directory using rm * -f. Start server2 for the new HPEL settings to take affect. Note the new log file and
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directory structure that is created when running HPEL.

= root@think:/opt/IBM/WebSphere/AppServer/profiles/AppSrvOl/logs/server2

File Edit View Terminal Tabs Help

[root@think server2]# 1s -al
total 32

drwxr-xr-x 4 root root 4096 Sep 30 23:15 .
drwxr-xr-x 7 root root 4096 Sep 29 15:55 ..
drwxr-xr-x 3 root root 4096 Sep 30 23:15 logdata
-rw-r--r-- 1 root root 168 Sep 30 23:15 native stderr.log
-rw-r--r-- 1 root root 1886 Sep 30 23:15 native stdout.log
-rw-r--r-- 1 root root 5 Sep 30 23:15 server2.pid
-rw-r--r-- 1 root root 2434 Sep 30 23:15 startServer.log

2

drwir-xr-x root root 4096 Sep 30 23:15 tracedata
[root@think server2]# |j

9. In the Admin Console, navigate to Troubleshooting -> Logs and Trace —> server2 and note the screen
Logging and tracing > server2 screen now shows the current custom HPEL settings for server2.

Logging and tracing

+ Logging and tracing > server2 o o

Use this page to select a system log to configure, or to specify log detail levels for comiponents and groups of
components.

General Properties

Directory /opt/IBM/WebSphere/AppServer/profiles/AppSrv01/logs/server2

For cleanup, delete records older than Disabled
For cleanup, maximum size of logs 20 Megabytes
. Configure HPEL trace 3
Directory /opl/IBM/WebSphere/AppServer/profiles/AppSrv01/logs/server2
For cleanup, delete records older than 12 Hours

For cleanup, maximum size of trace  Disabled
Configure HPEL text log

Current status: Disabled

You’re ready to proceed to part 1.6
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1.6 Use the HPEL command line log viewer

10. Since you enabled HPEL and restarted the server, the legacy WebSphere Application Server logging
information is no longer available. The command line HPEL log viewer provides a powerful, yet simple
solution for viewing logging information.

The following WebSphere Application Server V8.0 Information Center topic includes a detailed reference
of the command line viewer options: LogViewer command-line tool

___a. Open a terminal window and navigate to the /opt/IBM/WebSphere/AppServer/bin directory to
launch the HPEL log viewer.
11. At the command prompt, type ./logViewer.sh —help | more to view the HPEL log viewer command line
options.
12. Create a legacy format log file and compare its contents to the output of several HPEL log viewer
commands. Run the following command to create a legacy format log file (legacyFormat.log) that
contains only log records (INFO, WARNING, and SEVERE):

JlogViewer.sh -outLog ../logs/legacyFormat.log -minLevel INFO -maxLevel SEVERE

[root@think bin]# ./logViewer.sh -outlLog ../logs/legacyFormat.log -minLevel INFO -maxLevel SEVERE
Using /opt/IBM/WebSphere/AppServer/profiles/AppSrv0l/logs/server2 as repository directory.
Operation Complete

Processed 227 records in 0.07 seconds (3,242.857 records per second).

[root@think bin]# [}

13. Type cat ../logs/legacyFormat.log | more to view the log file.
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14.

[root@think bin]# cat ../logs/legacyFormat.log | more

*amEasrkssx® Start Display Current Environment #*####ssissis

WebSphere Platform 8.0.0.0 [ND 8.0.0.0 nl1118.03] running with process name thinkCell@l\thinkNode®@l\server2 and process id
10620

Host Operating System is Linux, version 2.6.18-238.12.1.el5

Java version = 1.6.0, Java Compiler = j9jit26, Java VM name = IBM J9 VM

was.install.root = /opt/IBM/WebSphere/AppServer

user.install.root = /opt/IBM/WebSphere/AppServer/profiles/AppSrvol

Java Home = /opt/IBM/WebSphere/AppServer/java/jre

ws.ext.dirs = /opt/IBM/WebSphere/AppServer/java/lib:/opt/IBM/WebSphere/AppServer/profiles/AppSrv@l/classes:/opt/IBM/WebSph
ere/AppServer/classes:/opt/IBM/WebSphere/AppServer/lib:/opt/IBM/WebSphere/AppServer/installedChannels:/opt/IBM/WebSphere/A
ppServer/lib/ext:/opt/IBM/WebSphere/AppServer/web/help:/opt/IBM/WebSphere/AppServer/deploytool/itp/plugins/com.ibm.etools.
ejbdeploy/runtime

Classpath = /opt/IBM/WebSphere/AppServer/profiles/AppSrv@l/properties:/opt/IBM/WebSphere/AppServer/properties:/opt/IBM/Web!
Sphere/AppServer/lib/startup.jar:/opt/IBM/WebSphere/AppServer/lib/bootstrap.jar:/opt/IBM/WebSphere/AppServer/lib/jsf-nls.]j
ar:/opt/IBM/WebSphere/AppServer/lib/lmproxy.jar:/opt/IBM/WebSphere/AppServer/1lib/urlprotocols.jar:/opt/IBM/WebSphere/AppSe!
rver/deploytool/itp/batchboot.jar:/opt/IBM/WebSphere/AppServer/deploytool/itp/batch2.jar:/opt/IBM/WebSphere/AppServer/java
/lib/tools.jar

Java Library path = /opt/IBM/WebSphere/AppServer/lib/native/1inux/x86_32/:/opt/IBM/WebSphere/AppServer/java/jre/1ib/1386/d
efault:/opt/IBM/WebSphere/AppServer/java/jre/1ib/i386:/opt/IBM/WebSphere/AppServer/lib/native/1inux/x86_32/:/opt/IBM/WebSp
here/AppServer/bin::/usr/lib:

Orb Version = IBM Java ORB build orb626fpl-20110419.00

*amsssssssssx End Display Current Environment #ssssssssssix

[9/306/11 23:15:11:116 EDT] 00000000 ManagerAdmin I TRASO017I: The startup trace state is *=info.

[9/306/11 23:15:11:120 EDT] 00000000 ManagerAdmin I TRASO111I: The message IDs that are in use are deprecated

[9/306/11 23:15:11:155 EDT] 00000000 ModelMgr I  WSVRO80OI: Initializing core configuration models

[9/306/11 23:15:11:438 EDT] 00000000 ComponentMeta I WSVRO179I: The runtime provisioning feature is disabled. All compone
nts will be started.

[9/306/11 23:15:11:488 EDT] 00000000 ProviderTrack I com.ibm.ffdc.osgi.ProviderTracker AddingService FFDC1007I: FFDC Provid
er Installed: com.ibm.ffdc.util.provider.FfdcOnDirProvider@16db5643

[9/30/11 23:15:11:494 EDT] 00000000 ProviderTrack I com.ibm.ffdc.osgi.ProviderTracker AddingService FFDC1007I: FFDC Provid
er Installed: com.ibm.ws.ffdc.impl.FfdcProvider@l16dbcbll

[9/306/11 23:15:11:615 EDT] 00000000 AdminInitiali A ADMNOO15I: The administration service is initialized.

[9/36/11 23:15:11:820 EDT] 00000000 PluginConfigS I PLGCOO57I: The plug-in configuration service started successfully.
[9/306/11 23:15:11:833 EDT] 00000000 SSLComponentI I CWPKIOOO1I: SSL service is initializing the configuration

[9/306/11 23:15:11:837 EDT] 00000000 WSKeyStore W  CWPKIOQO41W: One or more key stores are using the default password.
[9/30/11 23:15:11:842 EDT] 00000000 SSLConfigMana I CWPKIOO27I: Disabling default hostname verification for HTTPS URL co
nnections.

[9/306/11 23:15:11:848 EDT] 00000000 SSLDiagnostic I CWPKIOO14I: The SSL component's FFDC Diagnostic Module com.ibm.ws.ss
l.core.SSLDiagnosticModule registered successfully: true.

[9/306/11 23:15:11:848 EDT] 00000000 SSLComponentI I CWPKIOOO2I: SSL service initialization completed successfully
[9/306/11 23:15:11:850 EDT] 00000000 DiagnosticCon I com.ibm.wsspi.rasdiag.DiagnosticConfigHome setStateCollectionSpec RASD
0012I: Updating State Collection Spec from Uninitialized Value to .*:.*=0

[9/306/11 23:15:11:852 EDT] 00000000 PMIImpl A CWPMI1001I: PMI is enabled

[9/30/11 23:15:11:925 EDT] 00000000 WSChannelFram A CHFWO021I: Inbound chain WCInboundAdmin has been marked disabled.
[9/30/11 23:15:11:927 EDT] 00000000 WSChannelFram A CHFW0021I: Inbound chain WCInboundAdminSecure has been marked disabl
ed.

[9/30/11 23:15:12:024 EDT] 00000000 GAPAgentCompo I CWLRS6000I: GAP (Grid Application Placement) Component has initializ
ed successfully on process ManagedProcess.

[9/306/11 23:15:12:047 EDT] 00000000 SibMessage I [:] CWSIUGOOOI: Release: WAS80.SIB Level: dl115.28

[9/30/11 23:15:12:086 EDT] 00000000 SecurityDM I SECJ0231I: The Security component's FFDC Diagnostic Module com.ibm.w

IBM Proof of Technology

Run the following command to view only the log records for thread 0: ./logViewer.sh -thread 0 We will
only see the log file output for thread 0. We can send the output of the log view thread 0 command to a
text file with the addition of the —outLog <filename> switch: ./logViewer.sh -outLog myThread0.log —

thread 0. View the output with the cat or the more command.

Lab 3
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[root@think bin]# ./logViewer.sh -thread 0

Using /opt/IBM/WebSphere/AppServer/profiles/AppSrv@l/logs/server2 as repository directory.

*axxxsxrrrrx Start Display Current Environment *####ssssssx

WebSphere Platform 8.0.0.0 [ND 8.0.0.0 nl118.03] running with process name thinkCell@l\thinkNodeO@l\server2 and process id

10620

Host Operating System is Linux, version 2.6.18-238.12.1.el5

Java version = 1.6.0, Java Compiler = j9jit26, Java VM name = IBM J9 VM

was.install.root = /opt/IBM/WebSphere/AppServer

user.install.root = /opt/IBM/WebSphere/AppServer/profiles/AppSrv0l

Java Home = /opt/IBM/WebSphere/AppServer/java/jre

ws.ext.dirs = /opt/IBM/WebSphere/AppServer/java/lib:/opt/IBM/WebSphere/AppServer/profiles/AppSrv0l/classes:/opt/IBM/WebSph
ere/AppServer/classes:/opt/IBM/WebSphere/AppServer/1lib:/opt/IBM/WebSphere/AppServer/installedChannels:/opt/IBM/WebSphere/A
ppServer/lib/ext:/opt/IBM/WebSphere/AppServer/web/help:/opt/IBM/WebSphere/AppServer/deploytool/itp/plugins/com.ibm.etools.
ejbdeploy/runtime

Classpath = /opt/IBM/WebSphere/AppServer/profiles/AppSrv0l/properties:/opt/IBM/WebSphere/AppServer/properties:/opt/IBM/Web
Sphere/AppServer/lib/startup.jar:/opt/IBM/WebSphere/AppServer/lib/bootstrap.jar:/opt/IBM/WebSphere/AppServer/lib/jsf-nls.j
ar:/opt/IBM/WebSphere/AppServer/lib/lmproxy.jar:/opt/IBM/WebSphere/AppServer/lib/urlprotocols.jar:/opt/IBM/WebSphere/AppSe
rver/deploytool/itp/batchboot. jar:/opt/IBM/WebSphere/AppServer/deploytool/itp/batch2.jar:/opt/IBM/WebSphere/AppServer/java
/lib/tools.jar

Java Library path = /opt/IBM/WebSphere/AppServer/lib/native/1inux/x86 32/:/opt/IBM/WebSphere/AppServer/java/jre/1ib/1386/d
efault:/opt/IBM/WebSphere/AppServer/java/jre/1ib/1386:/opt/IBM/WebSphere/AppServer/lib/native/1linux/x86_32/:/opt/IBM/WebSp

15.

here/AppServer/bin::/usr/lib:

Orb Version = IBM Java ORB build orb626fpl-20110419.00

Frmmssssxrxxx End Display Current Environment ####ssssssssx

[9/30/11 23:15:11:116 EDT] 00000000 ManagerAdmin I TRASO017I: The startup trace state is *=info.

[9/30/11 23:15:11:120 EDT] 00000000 ManagerAdmin I  TRASO111I: The message IDs that are in use are deprecated
[9/30/11 23:15:11:155 EDT] 00000000 ModelMgr I  WSVRO80OI: Initializing core configuration models

[9/30/11 23:15:11:438 EDT] 00000000 ComponentMeta I ~ WSVRO179I: The runtime provisioning feature is disabled. All compone

nts will be started.

[9/30/11 23:15:11:488 EDT] 00000000 ProviderTrack I com.ibm.ffdc.osgi.ProviderTracker AddingService FFDC1007I: FFDC Provid

er Installed: com.ibm.ffdc.util.provider.FfdcOnDirProvider@l16db5643

[9/30/11 23:15:11:494 EDT1 00000000 ProviderTrack I com.ibm.ffdc.osai.ProviderTracker AddinaService FFDC1007I: FFDC Provid

Run the following command to view only WARNING messages: ./logViewer.sh -level WARNING We
can send the output of the log viewer WARNING command to text file like we did in the previous step.

[root@think bin]# ./logViewer.sh -level WARNING

Using /opt/IBM/WebSphere/AppServer/profiles/AppSrv0l/logs/server2 as repository directory.

*AFsxEsrxxx® Start Display Current Environment ###sssssssss

WebSphere Platform 8.0.0.0 [ND 8.0.0.0 nl1118.03] running with process name thinkCell@l\thinkNode@l\server2 and process id
10620

Host Operating System is Linux, version 2.6.18-238.12.1.el5

Java version = 1.6.0, Java Compiler = j9jit26, Java VM name = IBM J9 VM

was.install.root = /opt/IBM/WebSphere/AppServer

user.install.root = /opt/IBM/WebSphere/AppServer/profiles/AppSrvel

Java Home = /opt/IBM/WebSphere/AppServer/java/jre

ws.ext.dirs = /opt/IBM/WebSphere/AppServer/java/lib:/opt/IBM/WebSphere/AppServer/profiles/AppSrv0l/classes:/opt/IBM/WebSph

ere/AppServer/classes:/opt/IBM/WebSphere/AppServer/lib:/opt/IBM/WebSphere/AppServer/installedChannels:/opt/IBM/WebSphere/A

ppServer/lib/ext:/opt/IBM/WebSphere/AppServer/web/help:/opt/IBM/WebSphere/AppServer/deploytool/itp/plugins/com.ibm.etools.

ejbdeploy/runtime

Classpath = /opt/IBM/WebSphere/AppServer/profiles/AppSrv@l/properties:/opt/IBM/WebSphere/AppServer/properties:/opt/IBM/Web

Sphere/AppServer/lib/startup.jar:/opt/IBM/WebSphere/AppServer/lib/bootstrap.jar:/opt/IBM/WebSphere/AppServer/lib/jsf-nls.j

ar:/opt/IBM/WebSphere/AppServer/lib/lmproxy.jar:/opt/IBM/WebSphere/AppServer/lib/urlprotocols. jar:/opt/IBM/WebSphere/AppSe
rver/deploytool/itp/batchboot. jar:/opt/IBM/WebSphere/AppServer/deploytool/itp/batch2.jar:/opt/IBM/WebSphere/AppServer/java

/lib/tools. jar

Java Library path = /opt/IBM/WebSphere/AppServer/lib/native/1linux/x86_ 32/:/opt/IBM/WebSphere/AppServer/java/jre/1ib/1386/d

efault:/opt/IBM/WebSphere/AppServer/java/jre/1ib/1386:/opt/IBM/WebSphere/AppServer/lib/native/1inux/x86 32/:/opt/IBM/WebSp

here/AppServer/bin::/usr/1ib:

Orb Version = IBM Java ORB build orb626fpl-20110419.00

Frxmmaxssssrx End Display Current Environment ##ssssssssss

[9/30/11 23:15:11:837 EDT] 00000000 WSKeyStore W CWPKIOO41W: One or more Key stores are using the default password.
[9/30/11 23:15:12:657 EDT] 00000000 ThreadPoolMgr W  WSVRO626W: The ThreadPool setting on the ObjectRequestBroker service
is deprecated.

Operation Complete

Processed 2 records in 0.053 seconds (37.736 records per second).

[root@think bin]# [i
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_____16. Extract a specified set of log records to a new repository and a text file. Run the following command to
extract a repository of just WARNING and SEVERE messages and save the resulting file in a new
directory: ./logViewer.sh -minLevel WARNING -maxLevel SEVERE -extractToNewRepository
..llogs/InewHPELRepository

___a. .Run the following command to export the contents of the resulting repository to a text format log file:
JlogViewer.sh -repositoryDir ../logs/newHPELRepository -outLog ../logs/newFormat.log
___b. Use cat, tail, vi, or a text editor to view the resulting log file, for example: cat ../logs/newFormat.log

1.7 Use the HPEL log viewer included in the WebSphere
administrative console

1. Log in to the administrative console, specifying an appropriate user ID and password if administrative
security is enabled. Next, click TroubleShooting > Logs and Trace > server2. Then click View HPEL
logs and trace.

Logging and tracing 2?2/

Logging and tracing > server2

Use this page to select a system log to configure, or to specify log detail levels for components and groups of
components.

General Properties

Configure HPEL logging

Directory /opt/IBM/WebSphere/AppServer/profiles/AppSrv01/logs/server2
For cleanup, delete records older than Disabled

For cleanup, maximum size of logs 20 Megabytes
Configure HPEL trace

Directory /opt/IBM/WebSphere/AppServer/profiles/AppSrv01/logs/server2
For cleanup, delete records older than 12 Hours

For cleanup, maximum size of trace  Disabled
Configure HPEL text log

Current status: Disabled

Related Items

View HPEL logs and trace

Change iog detadii-ievels

Change log and trace mode

Manage process logs

NCSA access and HTTP error logging

2. Expand the Content and Filtering Details area of the page. Click each server instance (start time) to
view the corresponding log messages. Then collapse the Content and Filtering Details area. Since we
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have only stopped and started the server one time after enabling HPEL, you will probably only see
server instance.

= Content and Filtering Detalils

Server Instance

Server instances grouped by server start date and time:

3. Click the (early) log message TRAS0017I to view explanations, user actions, and so on. Then click
Close to remove the pop-up window.

Refresh View | Show Only Selected Threads | | Select Columns ... | Export... | Coy

Viewing log records from server instance October 1,2011 17:08:18

Number of records to show: (20

TimeStamp Thread ID Logger Level Message

10/1/11 17:08:18.269 00000000 édanagerAdmin
10/1/11 17:08:18.275 00000000 AanagerAdmin INFO TRASU111l: The message IDs that are in use are deprecated

10/1/11 17:08:18.319 00000000 nfig.ModelMgr INFO  WSVRO0800I: Initializing core configuration models

10/1/11 17:08:18.651 00000000  tMetaDataMgr INFO  WSVRO0179l: The runtime provisioning feature is disabled. All components will be started.
10/1/11 17:08:18.725 00000000 oviderTracker INFO  com.ibm.ffdc.osgi.ProviderTracker AddingService FEDC10071: FFDC Provider Installed: com.
10/1/11 17:08:18.732 00000000 oviderTracker INFO com.ibm.ffdc.osgi.ProviderTracker AddingService EEDC1007I: FFDC Provider Installed: com.
10/1/11 17:08:18.891 00000000 Adminlnitializer AUDIT ADMNOO015I: The administration service is initialized.

4. Locate a log entry indicating activity on a thread other than 00000000. Then select the entry and click
Show Only Selected Threads to filter the list to include only records generated by the same thread.
Finally, click Show All Threads to once again display messages generated by all threads. Note: You
may to scroll through a few pages of the log file to find thread other than 0000000.
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fresh View | Show Only Selected Threads | || select Columns ... | Export... | Copy to Clipboard | Server Instan

g log records from server insiaice Sctober 1, 2011 17:08:18

nber of records to show: |20 First Page | Previous Page |
Thread ID Logger Level ErMe-;s;ée ----------------------------------------------------------------------------------------------------------------------------------

00000007 Limpl.TCPPort SEVER TCPCOOOD3E: TCP Channel TCP_S initialization failed. The socket bind failed for host * and port 9356. The port may already be in use.

00000007 Limpl.TCPPort SEVER TCPCOOO3E: TCP Channel TCP_S initialization failed. The socket bind failed for host * and port 9356. The port may already be in use.

00000006 IL.TCPChannel INFO TCPCOOOLl: TCP Channel TCP_Sis listening on host * (IPv6) port 9356.

00000006 rameworklmpl AUDIT CHFEWO0O019I: The Transport Channel Service has started chain DCS.

00000005 rameworklmpl AUDIT CHFEWO0O019l: The Transport Channel Service has started chain DCS-Secure.

00000016 JRmmAdapter INFO DCSV1032: DCS Stack DefaultCoreGroup at Member thinkCellO1\thinkNodeOl\server3: Connected a defined member thinkCellO1\thinkNodeOl\server2.
1 00000016 JIRmmAdapter INFO DCSV1032I: DCS Stack DefaultCoreGroup at Member thinkCellO1\thinkNodeOl\server3: Connected a defined member thinkCellO1\thinkCellManagerO1\dt

* 00000016 JIRmmAdapter INFO DCSV1032I: DCS Stack DefaultCoreGroup at Member thinkCellO1\thinkNodeOl\server3: Connected a defined member thinkCellO1\thinkNodeOl\nodeager
00000017 /LeaderMerge INFO DCSV80541: DCS Stack DefaultCoreGroup at Member thinkCellO1\thinkNodeOl\server3: View change in process.

DCSV2004I: DCS Stack DefaultCoreGroup at Member thinkCellO1\thinkNodeOl\server3: View synchronization completed successfully. The View Identifier i
(10 thinkCellD1\thinkNadeN1\server3) The internal details are None

00000016 11.VSyncAlgol INFO

Thread ID Logger Level Message
00000017 vLeaderMerge INFO  DCSV8054I: DCS Stack DefaultCoreGroup at Member thinkCellO1\thinkNodeOl\server3: View change in process.

DCSVB070l: DCS Stack DefaultCoreGroup at Member thinkCellO1\thinkNodeOl\server3: Updated HA Manager state. New state version is CoreGr¢

gO00o0Ly (ERERRED DR DMGR true, time read 1317352460699, number coordinators 1, numberPreferred O, numberProcesses 4, version a7a48439137464e2{461cc96938

00000017 omponentimpl INFO HMGROO86I: This server is updating its core group configuration. The new document version is CoreGroupConfig : MemberName dmar, DMGR tru
P P number coordinators 1, numberPreferred 0. numberProcesses 4, version a7a48439137464e2f461cc96938a78d23101a777.
00000017 oordinatorlmpl INFO  HMGRO228I: The Coordinator is not an Active Coordinator for core group DefaultCoreGroup. The active coordinator set is [thinkCellO1\thinkCellMan

HMGRO0218I: A new core group view has been installed. The core group is DefaultCoreGroup. The view identifier is (12:0.thinkCellO1\thinkCellMar

00000017 oordinatorlmpl  INFO " R X
members in the new view is 4.

: DCS Stack DefaultCoreGroup at Member thinkCellO1\thinkNodeOl\server3: New view installed, i tifier (12:0.thinkCellO1\thinkCell

CN=4, DF=4)

6. Show only WARNING and higher level messages.

a. Expand the Content and Filtering Details area of the page.

b. Uncheck System out and System err.

c. Under Logs and trace, set Minimum level to WARNING and Maximum level to FATAL.

d. Click Apply to filter the list. (It may take several seconds for the filtering to be applied.) Then collapse
the Content and Filtering Details area of the page and view the resulting messages.
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1 . View Contents Filtering
\: System out Wild cards: *,?,% are allowed
\ System err Separate multiple entries by a ;'
+| Logsand trace Include loggers: ’
2 Minimum level: Exclude loggers: ’
: ‘WARNING =

Message contents: ’

Maximum level

‘FATAL - Event Timing

. From: On:
3 o
pply | | Reset | Until: Oon: |

Refresh View | Show Only Selected Threads ] Select Columns ... | Export ... | Copy to Clipboard | Se

Viewing log records from server instance October 1, 2011 17:08:18

Number of records to show: |20 | |

Thread ID Logger Level Message
19.186 00000000 g.WSKeyStore WARNI CWPKIO041W: One or more key stores are using the default password.
20.169 00000000 1dPoolMagrimpl  WARNI WSVRO0626W: The ThreadP ool setting on the ObjectRequestBroker service is deprecated.
21.074 00000000 Limpl. TCPPort SEVER TCPCOOO3E: TCP Channel TCP_S initialization failed. The socket bind failed for host * and port 9356. The port may already be in use.
21.075 00000000 rameworklmpl SEVER CHFWO0O034W: The Transport Channel Service detected transport chain DCS failed. The service will retry to start chain DCS every 5,000 milli
21.078 00000000 Limpl.TCPPort SEVER TCPCOO003E: TCP Channel TCP_S initialization failed. The socket bind failed for host * and port 9356. The port may already be in use.
21.078 00000000 rameworkimpl SEVER gnHel::/]Vpi)SO&W: The Transport Channel Service detected transport chain DCS-Secure failed. The service will retry to start chain DCS-Secure e
26.095 00000006 Limpl. TCPPort SEVER TCPCOOO3E: TCP Channel TCP_S initialization failed. The socket bind failed for host * and port 9356. The port may already be in use.

7. Export the filtered view to a binary repository and use the command line log viewer to display the
records.

a. Click Export.

Refresh View | Show Only Selected Threads | | Select Columns ... | Export... | Copy to Clipboard ]_

Viewing log records from server instance October 1, 2011 17:08:18

Number of records to show: |20 |

Thread ID Logger Level Message
19.186 00000000 g.WSKeyStore WARNI CWPKIO041W: One or more key stores are using the default password.
20.169 00000000 1dPoolMgrimpl  WARNI WSVRO626W: The ThreadPool setting on the ObjectRequestBroker service is deprecated.
21.074 00000000 Limpl.TCPPort SEVER TCPCOOO3E: TCP Channel TCP_S initialization failed. The socket bind failed for host * and port 9356. The port may already be in use.
21.075 00000000 rameworklmpl SEVER CHEWOO034W: The Transport Channel Service detected transport chain DCS failed. The service will retry to start chain DCS every 5000
21.078 00000000 Limpl. TCPPort SEVER TCPCOOO3E: TCP Channel TCP_S initialization failed. The socket bind failed for host * and port 9356. The port may already be in use.

b. Within the Select Export Options window, set the log format to Binary format and the log content to
Current view only. Then click OK.
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Select the options for export

Select log format

(® Binary format (readable by LogViewer)

() Basicformat

() Advanced format

Select log content

(@ Currentview only

(1 Whole Repository

OK Cancel

c. In the File Download window, select Save File then click OK. _
’)  Opening logs_thinkCellO1_thinkNodeOl_server2.zip X

You have chosen to open

€ logs_thinkCell01_thinkNodeOl_server2.zip

which is a: ZIP archive
from: https://10.10.10.101:9043

What should Firefox do with this file?

) Open with { Archive Manager (defaulr)

4

(@):Save File

[] Do this autematically for files like this from mow on.

[XCancel’ F & ok
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d. In the Save As window, select the application server profile logs directory, for example,
lopt/IBM/WebSphere/AppServer/profiles/AppSrv01/logs

Accept the default file name. Click Save. Note: In Firefox it downloads the file to a downloads directory
and you will have to copy the file the logs file directory described above.

e. Locate the exported repository, for example, logs_AppSrv01Cell_AppSrv01Node_server2.zip.

f. Use a suitable archiving utility to extract the files to a subdirectory within the application server profile
logs directory, for example, logs_AppSrv01Cell_AppSrvO01Node_server1.

root@think:/opt/IBM/WebSphere/AppServer/profiles/AppSrvOl/iogs
File Edit View Terminal Tabs Help

[root@think logs]# unzip logs thinkCell@l thinkNode®l server2.zip -d logs_ AppSrv01lCell AppSrvO1lNode server2
Archive: Tlogs_ thinkCell01l thinkNode®l server2.zip

creating: logs AppSrv01lCell AppSrv01lNode server2/1317503101524 24890-server2/

inflating: logs AppSrv01Cell AppSrvO1lNode server2/1317503101524 24890-server2/1317503101524.wb1l
[root@think logsl# ]

g. Open a command prompt and change to the application server profile bin directory, for example,

lopt/IBM/WebSphere/AppServer/profiles/AppSrv01/bin h. Run the logViewer command with the —
repositoryDir option to view the log messages present in the exported repository,

JlogViewer.sh -repositoryDir ../logs/logs_AppSrv01Cell_AppSrv01Node_server2

[root@think bin]# ./logViewer.sh -repositoryDir ../logs/logs AppSrv01Cell AppSrv0lNode server2

wadaaaEaxxx® Start Display Current Environment #### & s stk

WebSphere Platform 8.0.0.0 [ND 8.0.0.0 nl118.03] running with process name thinkCellO@l\thinkNode®l\server2
and process id 24890

Host Operating System is Linux, version 2.6.18-238.12.1.el5

Java version = 1.6.0, Java Compiler = j9jit26, Java VM name = IBM J9 VM

was.install.root = /opt/IBM/WebSphere/AppServer

user.install.root = /opt/IBM/WebSphere/AppServer/profiles/AppSrvol

Java Home = /opt/IBM/WebSphere/AppServer/java/jre

ws.ext.dirs = /opt/IBM/WebSphere/AppServer/java/lib:/opt/IBM/WebSphere/AppServer/profiles/AppSrv0l/classes:
/opt/IBM/WebSphere/AppServer/classes:/opt/IBM/WebSphere/AppServer/lib:/opt/IBM/WebSphere/AppServer/installe
dChannels:/opt/IBM/WebSphere/AppServer/lib/ext:/opt/IBM/WebSphere/AppServer/web/help:/opt/IBM/WebSphere/App
Server/deploytool/itp/plugins/com.ibm.etools.ejbdeploy/runtime

Classpath = /opt/IBM/WebSphere/AppServer/profiles/AppSrv@l/properties:/opt/IBM/WebSphere/AppServer/properti
es:/opt/IBM/WebSphere/AppServer/lib/startup.jar:/opt/IBM/WebSphere/AppServer/lib/bootstrap.jar:/opt/IBM/Web
Sphere/AppServer/lib/jsf-nls.jar:/opt/IBM/WebSphere/AppServer/lib/lmproxy.jar:/opt/IBM/WebSphere/AppServer/
lib/urlprotocols.jar:/opt/IBM/WebSphere/AppServer/deploytool/itp/batchboot.jar:/opt/IBM/WebSphere/AppServer
/deploytool/itp/batch2.jar:/opt/IBM/WebSphere/AppServer/java/lib/tools. jar

Java Library path = /opt/IBM/WebSphere/AppServer/lib/native/1inux/x86_32/:/opt/IBM/WebSphere/AppServer/lib/
native/linux/x86_32/:/opt/IBM/WebSphere/AppServer/java/jre/1ib/i386/default:/opt/IBM/WebSphere/AppServer/ja
va/jre/1ib/1386:/opt/IBM/WebSphere/AppServer/lib/native/1inux/x86_32/:/opt/IBM/WebSphere/AppServer/bin::/us
r/lib::

Orb Version = IBM Java ORB build orb626fpl-20110419.00

wamaaarxrrrxx End Display Current Environment #*####&ssssiis

[16/1/11 17:05:01:524 EDT] 00000000 WSKeyStore W CWPKIOO41W: One or more Key stores are using the defa
ult password.

[16/1/11 17:05:02:566 EDT] 00000000 ThreadPoolMgr W  WSVR0626W: The ThreadPool setting on the ObjectReques
tBroker service is deprecated.

[16/1/11 17:08:09:646 EDT] 00000026 DiscoveryTx W DCSV1115W: DCS Stack DefaultCoreGroup at Member think|
Cell01\thinkNodeOl\server2: Member thinkCell01l\thinkNode®l\server3 connection was closed. Member will be
removed from view. DCS connection status is Discovery|Ptp, transmitter closed.

Operation Complete

Processed 3 records in 0.017 seconds (176.471 records per second).

[root@think bin]# ||
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8. Return to the administrative console. Then click Reset, followed by Apply to remove all filtering.

View Contents Filtering

| System out

Wild cards: *,?,% are allowed
| System err

Separate multiple entries by a "'

¥| Logs and trace Include loggers: \

Minimum level:

Exclude loggers: ‘

| -

Message contents: ‘
Maximum level

| bt Event Timing

From: | On: I
Apply | | iReset Until: ‘ On: ‘

9. Log out of the administrative console.

I This page is left intentionally blank. I

Lab 3 Page 21



